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   1. Исследование электрических фильтров типа «k» 

Целью контрольной  работы является экспериментальное исследование  
частотных характеристик реактивных электрических фильтров типа «k» ниж-
них и верхних частот. 

                     Основные теоретические положения 

Электрическим фильтром называется линейный четырехполюсник, предна-
значенный для выделения  из состава сложного электрического сигнала, подве-
денного к его входным зажимам, частотных составляющих, расположенных в 
заданной полосе частот, и подавления тех составляющих, которые расположе-
ны в других, также заданных полосах частот. Они обладают малым и приблизи-
тельно постоянным затуханием в полосе частот, называемой полосой прозрач-
ности (полосой пропускания), и достаточно большим затуханием вне этой по-
лосы. Частотная область затухания называется полосой заграждения (полосой 
задерживания). Частота, разделяющая эти полосы, называется частотой среза. 

Приведем классификацию фильтров по взаимному расположению полос 
пропускания  и задерживания. На рис. 1.1 приведены  идеальные АЧХ фильт-
ров низких частот (ФНЧ), фильтров верхних частот (ФВЧ), полосовых фильт-
ров (ПФ) и полосно-заграждающих (режекторных) фильтров (ПЗФ). 

Рассмотрим основное соотношение теории фильтров. Пусть Т- или П-об-
разные звенья фильтра (рис. 1.2) содержат только реактивное  сопротивление. 

 
 

 

Рис. 1.1 

 

Рис. 1.2 
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Тогда величина 
 1121 21 AZZgch   (1.1) 

является вещественной. Учитывая, что jbag  , получаем 
 
                      ( ) cos sin .ch g ch a jb cha ch jb sha sh jb cha b jsha b       
 

Отсюда 

      11cos ,
sin 0.

cha b A
sha b




 

 
Последнее равенство удовлетворяется при 0a  или при 0b . При этом 

если 0a , то 1ch a  , поэтому 11cos Ab  . Это выполняется только при 

11 1A  .  
Следовательно, реактивный фильтр пропускает сигналы без затухания, если 
 
 041 21  ZZ .   (1.2) 
 
Это неравенство является основным соотношением теории фильтров. Оно 

позволяет определить полосу пропускания фильтра. 
За пределами полосы пропускания 0b , 1cos b , т. е. 

                                                       1 21 2 .ch a Z Z   (1.3) 

Выражение (1.3) позволяет определить затухание в полосе непропускания. 
 

Фильтры типа «k» 
Если в звеньях фильтра 1Z  и 2Z  являются  реактивными сопротивлениями  

противоположного характера ( 11 jXZ  , 22 jXZ  ), то их произведение 
 
  2

21 kZZ    (1.4) 
 

является постоянной величиной и не зависит от частоты. Такие фильтры назы-
ваются фильтрами типа «k». 

Фильтр нижних частот 
Фильтр нижних частот пропускает без затухания ( 0a  ) угловые частоты от 

= 0  до c = 2 LC .  
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Т- и П-образные звенья фильтров нижних частот  приведены на рис. 1.3 а, б. 

Основными качественными показателями фильтра являются его частотные 
характеристики:  1( )a f  , 2 ( )b f  ,  стZ  и сп ( )Z  . 

В полосе пропускания ФНЧ ( c<  ) затухание сигнала равно нулю ( 0a  ), 
а коэффициент фазы определяется из уравнений (1.1) и (1.2): 

  1

2 c
sin 2 4

Xb
X


  .  (1.5) 

В полосе заграждения ( С>  ) коэффициент затухания определяется соот-
ношением 

  1

2 c2 4
Xach X


  ,  (1.6) 

а коэффициент фазы b  . 
На рис. 1.4 приведены частотные характеристики для ФНЧ. 

Зависимость от частоты характеристического сопротивления фильтра мож-
но определить из выражений для характеристических сопротивлений четырех-
полюсника: 

для Т-образного звена 
 
  1 2 1 2ст (1 4 )Z Z Z Z Z  ;  (1.7) 
 
 
 
 

 

               а                                 б 

Рис. 1.3 

 
 
 
              Рис. 1.4 
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для П-образного звена 

  1 2
1 2

сп
1

(1 4 )Z Z Z Z Z 
.  (1.8) 

Для ФНЧ эти выражения с учетом значений 1Z  и 2Z  приобретают вид 
2

2cп 1
c

LZ
C




  ;           

-1
2

2cп 1
с

LZ
C




 
    
 

.                      (1.9) 

Зависимость характеристического сопротивления ФНЧ от частоты показана 
на рис. 1.5. 

Фильтр верхних частот 
Фильтр верхних частот пропускает без затухания ( 0a ) угловые частоты: 

от c
1

2 LC
   до    . 

Схемы Т-образного и П-образного звеньев ФВЧ приведены соответственно 
на рис. 1.6, а и 1.6, б. 

В полосе заграждения ФВЧ ( c<  ) коэффициент фазы постоянен и равен 
-р . Затухание определяется следующим выражением: 

  
с2

ach 


 .  (1.10) 

                            

   
 

Рис. 1.6 

 

Рис. 1.5 
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В полосе пропускания ( с>  ) коэффициент затухания равен нулю ( 0a  ), а ко-
эффициент фазы: 

 0
2

2 2
21cos 1 1 .

2
b

LC


 
      (1.11) 

На рис. 1.7 приведены частотные характеристики ( )a  и ( )b   для ФВЧ. 

Характеристические сопротивления стZ  и спZ  для ФВЧ определяются: 
для Т-образного звена 

  
2

ст
с1LZ

C



    
 

; (1.12) 

для П-образного звена 

  

1
2

сп
с1 .LZ

C




         

  (1.13) 

Зависимость характеристического сопротивления от частоты ФВЧ показана 
на рис. 1.8. 

 
 

 

Рис. 1.7 

 

Рис. 1.8 
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Влияние числа звеньев на их характеристики 
Для упрощения анализа фильтров предполагается, что активные потери 

элементов фильтра равны нулю, поэтому в полосе пропускания коэффициент 
затухания также строго равняется нулю, даже при каскадном включении не-
скольких звеньев. В полосе затухания коэффициент затухания а  и коэффици-
ент фазы b растут  пропорционально числу звеньев: nа , nb . Графически это вы-
ражается  в росте крутизны кривой зависимости затухания от числа звеньев в 
цепи (рис. 1.9). 

В реальных цепях наиболее ощутимо увеличение затухания при n = 52 . 
С дальнейшим ростом n крутизна затухания растет медленно. 
 

Согласованное включение фильтров 
Избирательные свойства фильтра лучшим образом проявляются при согла-

совании его с генератором и нагрузкой, т. е. при условии согласования фильтра: 
 

1cZ Z  ; 2cZ Z  , 

где Z – внутреннее сопротивление генератора; Z – сопротивление нагрузки; 
1cZ  и 2cZ – характеристические сопротивления фильтра. 

У симметричных фильтров 1c 2c cZ Z Z  , поэтому коэффициенты затуха-
ния и фазы выражаются формулами 

 

  
2

1ln
U

Ua   ;       1 2b    , (1.14) 

где 11 1
jU U e  – напряжение на входе фильтра; 222

jU U e  – напряжение на вы-
ходе фильтра. 

Соотношение (1.14) используется для экспериментального определения ко-
эффициентов a  и b . 

Очевидно, что режим согласования фильтров типа «k» весьма условен, так 
как сопротивления стZ  и спZ  являются функциями частоты, впрочем, Z  и ГZ  

 
             Рис. 1.9 
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 могут быть частотно зависимыми. Поэтому в частотном диапазоне условие со-
гласования нарушается и принятая упрощённая модель фильтра не отражает 
существа явлений. Следствием этого становится то, что вблизи частоты среза 

C  зависимость  a   имеет отличный от расчётного характер. 
 

Расчёт фильтров типа «k» 
Обычно для расчёта фильтра задаются частота среза с  или сf  и сопротив-

ление нагрузки R , необходимо определить элементы Т- или П-образной схе-
мы фильтра. В табл. 1.1 приведены схемы полузвена и формулы параметров ре-
активных фильтров типа «k»: нижних частот (ФНЧ), верхних частот (ФВЧ), по-
лосовых (ПФ). 

 
Таблица 1.1 

 ФНЧ ФВЧ ПФ 
Схема полу-

звена 

   

21ZZR   
2

1
C

L  
1

2
C

L  
1

2
2

1
C

L
C

L   

Частоты среза 

1 2

1
Сf L C
  

2 1

1
4Сf L C

  
1,2

1 2 1 1 2 1

1 1 1 1
2

f
LC LC L C

 
  

  
  

 
Z  2

1















Сf

fR  

2

1 









f
fR С  21 R  

Z  
 2

1

















Сf

f

R
 

2

1 











f

f

R

С

 

21 


R
 

 
Формулы для 
расчета эле-

ментов 
фильтра 

1
С

RL
f



2
1

С
C

f R
  

2 4 С

RL
f



1
1

4 С
C

f R
  

1
2 1

;
( )

RL
f f




2 1
1

1 24
f fC

f f R


  

2 1
2 2

1 2 2 1

( ) 1;
4 ( )
R f fL C

f f f f R 


 

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Примечание.   

2

2

f

f

f

f
f

f

f

f

m

m

m

m





 ,   где .1 2mf f f  

Фильтры типа «m» (рис. 1.10 а, б) являются производными фильтров типа 
«k». Изменение плеч полузвена  типа «k» по схеме рис. 1.10, а приводит к по-
следовательно-производному полузвену типа «m», характеристическое сопро-
тивление Z  которого совпадает  с сопротивлением Z  исходного звена типа 
«k» – прототипа производного фильтра. Изменение плеч полузвена типа «k» по 
схеме рис. 1.10, в приводит к параллельно-производному полузвену типа «m», у 
которого характеристическое сопротивление Z  совпадает с соответствующим 
сопротивлением прототипа – исходного звена типа «k». 

В табл. 1.2 приведены схемы полузвеньев фильтров типа «m». 
Таблица 1.2 

 ФНЧ ФВЧ ПФ 
Схема по-
следова-
тельно-
производ-
ного по-
лузвена 
типа «m» 

 
 

Схема 
парал-
лельно- 
произ-
водного 
полузвена 
типа «m»  

 
Рис.1.10 
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Фильтры типов «k» и «m» могут быть соединены каскадно на основе равен-
ства характеристических сопротивлений при одинаковых частотах среза и но-
минальных характеристических сопротивлениях. 

 

 

 
 

Рис. 1.11 

 

Домашнее задание 
1. Начертить электрическую схему фильтра (рис. 1.11). Пронумеровать уз-

лы и элементы ветвей. 
2. Рассчитать элементы схемы. 
3. Написать программу для расчета АЧХ фильтра в трех точках (1, 2, 3). 
4. Написать программу для расчета переходного процесса в трех точках 

).(),(),( 321 tUtUtU  На входе действует источник прямоугольных импульсов с 
частотой вхf (меандр). 

5. Расчет произвести с помощью пакета прикладных программ PSPICE. 
6. Активное сопротивление всех катушек индуктивности принять равным 

0,3 Ом. 
7. На рис. 1.11–1 «m» и 3 «m» – Г-образные звенья фильтра типа «m» 

(табл. 1.2), а 2 «k» – фильтр типа «k», вид фильтра и его параметры заданы в 
табл. 1.3 в соответствии с номером варианта. 

8. Расчет фильтров произвести по методике, указанной в учебнике: Атабе-
ков Г. И. Теоретические основы электротехники. – М. : Энергия, 1978. 

 
Пример расчёта 

Следует спроектировать фильтр нижних частот с частотой сре-
за СР 1000Гцf  ; н 200 Ом;R   .5,0m  Вид фильтра типа «k» – П-образный. 
Частота источника прямоугольных импульсов на входе фильтра 800вх f Гц. 

Электрическая схема фильтра, согласно заданию с учетом активных сопро-
тивлений катушек индуктивности 0,3 Омkr  , будет иметь вид (рис. 1.12). 
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Рис. 1.12 
 

Элементы канонической схемы фильтра типа «k» рассчитываем по формулам 
3

2 1
200 63,7 10

3,14 1000с

RL L
f

    


Гн; 

6
2

1 1 1,59 10 Ф
3,14 1000 200с n

C
f R

    
 

. 

Звено типа «m», имеющее то же характеристическое сопротивление, что и 
фильтр типа «k», является параллельно-производным. Его элементы рассчиты-
ваются по формулам табл. 1.2: 

3 3
1 3 1

1 1 0,5 63,7 10 16 10 Гн
2 2

L L mL         ; 







 6
2

61 1059,1
1

25,01

2

1 C
m

mCC ; 

.104,01059,15,05,0
2

1 66
52  CCC  

Программа расчета АЧХ фильтра и переходного процесса при подаче на 
вход прямоугольного импульса с помощью ППП PSPICE имеет вид: 

 FILTR NISKOY CHASTOTY 
 RG  5  4  200 
 R1   6  1  0.3 
 R2   7  2  0.3 
 R3   8  3  0.3 
 RN  3  0  200 
 L1   4  6  16 MH 
 L2   1  7  63.7 MH 
 L3   2  8  16 MH 
 C1   4  1  1.19 UF 
 C23   1  0  1.2 UF 
 C45   2  0  1.2 UF 
 C6   2  3   1.19 UF 
 VIN   5  0  AC 1 
  AC DEC  10  1  2 KHZ 
 PLOT AC V(1) V(2) V(3) 

*VIN  5  0  PULSE (0  1  0  0.625MS  1.25MS) 
* TRAN  12.5US  1.25MS 

 * PLOT  TRAN  V(4)  V(1)  V(2)  V(3) 
.PROBE 

  END 
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Таблица 1.3 
№ 

вари-
анта 

Вид 
фильт-

ра 

 
срf (Гц) 

НR  
(Ом) 

 
m 

Вид 
фильтра 
типа «k» 

 
вхf  

1 НЧ 900 180 0,45 П 700 
2 ВЧ 1500 220 0,6 Т 1400 
3 ПФ 1f 1800, 2f 2200 270 0,7 П 2000 
4 НЧ 2500 300 0,8 Т 2000 
5 ВЧ 3000 330 0,9 П 2900 
6 ПФ 1f 3300, 2f 3700 430 0,4 Т 3500 

7 НЧ 4000 470 0,5 П 3500 
8 ВЧ 4500 510 0,6 Т 4400 
9 ПФ 1f 4800, 2f 5200 560 0,7 П 5000 

10 НЧ   5500 620 0,8 Т 5000 
11 ВЧ   6000 680 0,9 П 5900 
12 ПФ 1f 6300, 2f 6800 680 0,5 Т 6500 
13 НЧ   7000 620 0,6 П 6500 
14 ВЧ   7500 560 0,7 Т 7400 
15 ПФ 1f 7800, 2f 8200 510 0,8 П 8000 
16 НЧ 8500 470 0,9 Т 8000 
17 ВЧ 9000 430 0,4 П 8900 
18 ПФ 1f 9300, 2f 9700 330 0,5 Т 9500 
19 НЧ 10000 300 0,6 П 9500 
20 ВЧ 10500 270 0,7 Т 10400 
21 ПФ 1f 10800, 2f 11200 220 0,8 П 11000 
22 НЧ 11500 200 0,9 Т 11000 
23 ВЧ 12000 180 0,5 П 11900 
24 ПФ 1f 12300, 2f 12700 160 0,6 Т 12500 
25 НЧ 13000 150 0,7 П 12500 
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2. СОСТАВ ПАКЕТА ПРИКЛАДНЫХ ПРОГРАММ ORCAD 
 Пакет прикладных программ Orcad предназначен для автоматизации про-
цесса проектирования электронных устройств. Он позволяет провести модели-
рование переходных процессов, рассчитать частотные и шумовые характери-
стики аналогового, цифрового или аналого-цифрового устройства, заданного 
принципиальной схемой, оптимизировать параметры устройства в соответствии 
с заданной целевой функцией, разработать печатную плату. Кроме перечислен-
ных возможностей последняя версия пакета (Orcad 10) включает новые воз-
можности по проектированию устройств на базе FPGA/CPLD интегральных 
схем; позволяет работать с программами размещения и трассировки от фирм-
изготовителей кристаллов Xilinx, Altera и Actel (при предварительной инстал-
ляции программ). 
 Назначение отдельных программ, входящих в состав пакета, приведено в 
табл. 2.1. 

Таблица 2.1 
Программы пакета Orcad 9.2 

Название программы Назначение 

Capture CIS 
Управляющая оболочка, позволяющая вводить и редак-
тировать принципиальную схему в графическом режиме, 
а также вызывать остальные программы пакета 

Layout Plus Разработка печатных плат 

PSpice AD Программа моделирования аналоговых, цифровых и 
аналого-цифровых устройств 

PSpice Model Editor Редактирование существующих и создание новых биб-
лиотек элементов 

PSpice Optimizer 
Оптимизация параметров устройства для достижения 
наилучшего функционирования в соответствии с целе-
вой функцией 

PSpice Simulation Manager Управление заданиями на моделирование устройства 

PSpice Stimulus Editor Редактор входных воздействий 

 
 Для выполнения нужных разработчику действий может вызываться либо 
непосредственно необходимая в данный момент программа (например PSpice 
Model Editor), либо управляющая оболочка (Capture CIS) с последующим выбо-
ром необходимого действия. Последний путь обладает большей целостностью 
и наглядностью и может быть рекомендован при создании нового проекта, а 
также начинающим пользователям. Запуск выбранной программы осуществ-
ляется либо с помощью меню Пуск (например, Пуск → Программы → Orcad 
Family Release 9.2 Lite Edition → Capture CIS Lite Edition), либо любым другим 
известным путем. 
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Рис. 3.1. Стартовое окно программы 

Рис. 3.2. Окно при создании  
нового проекта 

3. ПРОГРАММА CAPTURE CIS 
3.1. Рабочее окружение  

 После запуска на выполнение на экране появляется окно программы, при-
веденное на рис. 3.1. 

 В левом нижнем углу расположе-
но минимизированное окно Session 
Log, в которое записывается инфор-
мация о действиях, произведенных в 
течение сеанса работы с управляющей 
оболочкой.  
 При выборе пункта меню 
File→New программа Capture пред-
ложит создать: новый проект (Project), 
разработку (Design), библиотеку (Li-
brary), VHDL или текстовый файл. 
Файл проекта (расширение .OPJ) со-
держит указатель на один файл разра-

ботки (.DSN), а также библиотеки, VHDL-файлы, выходные файлы отчетов, 
связанные с файлом разработки. В файле разработки находятся одна или не-
сколько папок (schematic folders), содержащих по одному или несколько листов 
схемы (schematic pages), а также кэш разработки, который, подобно библиотеке, 
содержит копии всех элементов, использованных в разработке.  

При создании нового проекта на экране появится окно, представленное на 
рис. 3.2.  

Кроме имени проекта (Name) и его 
местоположения, на диске пользователя 
(Location) необходимо выбрать тип про-
екта: 
 Analog or Mixed A/D – при дальней-
шем использовании программы PSpice; 
 PC Board Wizard – при дальнейшем 
использовании программы Layout; 
 Programmable Logic Wizard – при 
разработке схемы на основе ПЛИС; 
 Schematic – при необходимости соз-
дания только чертежа принципиальной 
либо функциональной схемы без даль-
нейшего моделирования либо разработки 
печатной платы. 
 Создав новый или открыв сущест-

вующий проект, в левой части экрана можно увидеть окно менеджера проекта 
(рис. 3.3), который является удобным средством управления файлами проекта. 
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Рис. 3.3. Вид экрана при открытии проекта 

Для редактирования выбранного файла в отдельном окне необходимо про-
извести двойной щелчок левой кнопкой мыши на выбранной пиктограмме.  

Для добавления нового файла в проект необходимо: 
I вариант: 
 1) выбрать в менеджере проектов папку, в которую будет добавляться файл; 
 2) из меню Edit выбрать пункт Project; 
 3) выбрать нужный файл в появившемся диалоговом окне Add File to Project 
Folder и нажать кнопку Open. 
II вариант: 
 перетащить файл из окна Windows Explorer в нужную папку менеджера 
проекта. 
 Щелчок правой кнопкой мыши на файле или папке в окне менеджера про-
екта вызывает появление контекстного меню, зависящего от назначения данно-
го файла или папки. Вид контекстных меню для файлов, содержащих чертеж 
принципиальной схемы, и файлов, содержащих задание на моделирование, 
приведен на рис. 3.4, а и б соответственно. 
       Для удаления файла необходимо выделить его в окне менеджера проекта и 
нажать клавишу Delete. 
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Рис. 3.4. Контекстные меню 

 

 Удобным средством, облегчающим взаимодействие пользователя с про-
граммой, являются панели инструментов, взаимное положение которых можно 
изменять перетягиванием мышью. Назначение различных инструментов приве-
дено в табл. 3.1, 3.2 и 3.3. 

Таблица 3.1 
Инструменты Capture 

Пикто-
грамма Название Назначение Выполнение через 

Меню 

 

Перекрест-
ная ссылка 

Создает таблицу, содержащую инфор-
мацию о номинале элемента, его пози-
ционном обозначении, библиотечном 
источнике и др. 

Tools → Cross  
Reference 

 
 

 

Список ма-
териалов 

Создает список количества и номина-
лов элементов для выбранной страни-
цы 

Tools → Bill of 
Materials 

 

 

Привязка 
к сетке 

Включает (выключает) привязку к сет-
ке 

Options→ Preferences→ 
Grid Display→ Pointer 

snap to grid 

 

Менеджер 
проекта Отображает менеджер проекта Window → название 

проекта.opj 

 

Часто ис-
пользуе-
мый эле-

мент 

Вставляет элемент из списка наиболее 
часто используемых -- 

 

Увеличе-
ние Увеличение View → Zoom → In 

 

Умень-
шение Уменьшение View → Zoom → Out 

 

Увеличить 
выбранное 

Увеличивает выбранный прямоуголь-
ник View → Zoom → Area 

 

Увеличить 
все Показывает всю схему View → Zoom → All 

 

а б 
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Окончание табл. 3.1 
Пикто-
грамма Название Назначение Выполнение через 

Меню 

 
Связать Присваивает позиционные обозна-

чения введенным элементам Tools → Annotate 

 

Внести  
изменения 

Позволяет внести изменения, сделан-
ные в других программах (например 
Layout) 

Tools → Back Annotate 

 

Проверка 
правил 

Проверка схемы на выполнение ос-
новных электрических и конструк-
ционных правил. Позволяет найти 
ошибки 

Tools → Design Rules 
Check 

 

Создать 
описание 

схемы 

Создает файл-описание схемы в фор-
мате, задаваемом пользователем Tools → Create Netlist 

 
Таблица 3.2 

Инструменты редактора схем 
Пикто-
грамма Название Назначение Выполнение 

через меню 

 
Выбор Выбирает объекты  – 

 
Элемент Выбирает элемент из библиотеки 

для вставки в схему Place → Part 

 
Соединение 

Рисует провода, электрически со-
единяющие точки схемы. Удержа-
ние клавиши Shift позволяет рисо-
вать неортогональные провода 

Place → Wire 

 
Имя цепи Позволяет назначить имя проводу 

или шине Place → Net Alias 

 
Шина 

Рисует шины. Удержание клавиши 
Shift позволяет рисовать неорто-
гональные сегменты 

Place → Bus 

 
Узел Вводит узел Place → Junction 

 
Вход шины Рисует входы шины Place → Bus Entry 
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Окончание табл. 3.2 
Пикто-
грамма Название Назначение Выполнение 

через меню 

 
Питание Рисует символы питания Place → Power 

 
Земля Рисует символы «земли» Place → Ground 

 

Иерархичес-
кий блок Вставляет иерархический блок 

Place → Hierarchical 
Block 

 

 

Иерархи-
ческий порт Вставляет иерархический порт Place → Hierarchical 

Port 

 

Иерархи-
ческий вывод Вставляет иерархический вывод Place → Hierarchical Pin 

 

Межстра-
ничный со-
единитель 

Добавляет межстраничный 
соединитель 

Place → Off-Page Con-
nector 

 

Нет соедине-
ний 

Вставляет символ  
«нет соединения» Place → No Connect 

 
Линия Рисует линию Place → Line 

 
Полилиния Рисует линию с точками изгиба Place → Polyline 

 

Прямо-
угольник 

Рисует прямоугольник. Удержание 
клавиши Shift позволяет нарисовать 
квадрат 

Place → Rectangle 

 
Эллипс 

Рисует эллипс. Удержание клавиши 
Shift позволяет нарисовать пра-
вильный круг 

Place → Ellipse 

 
Дуга Рисует часть окружности Place → Arc 

 
Текст Позволяет вводить текст Place → Text 
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Рис. 3.6. Окно мастера создания 
PCB-проекта 

Таблица 3.3 
Инструменты редактора элементов 

Пикто-
грамма Название Назначение Выполнение 

через меню 

 

IEEE- 
символ 

Помещает на изображение эле-
мента его функциональное назна-
чение в виде стандартного IEEE-
символа 

Place → IEEE Symbol 

 
Вывод Рисует вывод элемента Place → Pin 

 

Массив  
выводов Рисует массив выводов Place → Pin Array 

  

В нижней части окна расположена строка состояния (рис. 3.5), на которой 
отображаются (слева направо) состояние выбранного инструмента либо пояс-
нение к пункту меню; количество выбранных элементов; текущий масштаб и 
положение курсора. 
 
 
 

Рис. 3.5. Строка состояния 

 Строку состояния и панели инструментов можно убрать с экрана, выбрав 
соответствующий пункт меню View. 
  

3.2. Подготовка схемы и моделирование на PSpice 
Перед созданием нового проекта необходимо в стартовом окне программы 

Capture (см. рис. 3.1)  выбрать  пункты  меню  Options → Design  Templates,   
Options → Preferences и установить требуемые единицы измерения, размеры 
страницы, шаг и привязку сетки,  другие необходимые параметры. В противном 
случае проект будет создан по шаблонам, установленным ранее. 

При создании нового проекта (File → New → Project) необходимо в окне 
создания нового проекта (см. рис. 3.2) указать его тип либо как «Analog or 

Mixed A/D», либо как «PC Board Wizard». В по-
следнем случае в появившемся окне мастера 
создания PCB-проекта (рис. 3.6) необходимо ак-
тивизировать пункт Enable project simulation. 

После создания проекта производится ввод 
принципиальной схемы пользователя с помо-
щью инструментов редактора принципиальных 
схем (см. табл. 3.3).  
Как правило, сначала производится ввод эле-
ментов принципиальной схемы с помощью 
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кнопки «Элемент» (или нажатия на клавиатуре клавиши P), при этом на экране 
появляется окно Place Part (рис. 3.7). В левом нижнем углу окна расположен 
список библиотек, из которого производится выбор нужного элемента, при 
этом путем выделения можно указать как одну библиотеку, так и все сразу. От-
метим, что для дальнейшего моделирования схемы с помощью программы 
PSpice необходимо выбирать только те элементы, которые снабжены моделью 
на языке моделирования, о чем свидетельствует наличие пиктограммы PSpice 
под изображением элемента. При необходимости дальнейшей разработки пе-
чатной платы элемент должен содержать также описание посадочного места, о 
чем свидетельствует наличие пиктограммы Layout. При необходимости список 
используемых библиотек можно увеличить либо уменьшить с помощью соот-
ветствующих кнопок, при этом библиотеки с моделями на языке PSpice распо-
ложены по адресу C:\Program Files\OrcadLite\Capture\Library\PSpice и имеют 
расширение *.olb. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 3.7. Назначение элементов окна Place Part 

 Если библиотека, содержащая нужный элемент, неизвестна, то можно про-
извести поиск во всех библиотеках из заданной папки с помощью команды Part 
Search. 
 При нажатии кнопки ОК курсор перемещается на страницу с принципиаль-
ной схемой, при этом ввод элемента осуществляется нажатием левой кнопки 
мыши. При необходимости поворота элемента щелчком правой кнопкой мыши 
вызывается контекстное меню, из которого выбирается пункт Rotate. После 
ввода нужного количества элементов производится либо вызов контекстного 
меню с последующим выбором команды End Mode, либо нажатие клавиши Esc. 
Электрическое соединение элементов производится с помощью инструмента 
«Соединение» (вызов либо с помощью панели инструментов, либо нажатием 
клавиши W). При этом щелчок в месте пересечения двух проводов добавляет 
узел, в противном случае пересекающиеся провода электрически не соединяют-
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Рис. 3.9. Окно при вызове инструмента 
GND 

ся. При необходимости изменения номинала либо позиционного обозначения 
элемента производится двойной щелчок мыши на изменяемом параметре. 
Двойной щелчок на изображении самого элемента вызывает редактор свойств; 
отбор и редактирование необходимых свойств проще осуществлять с использо-
ванием фильтра (рис. 3.8). 
 
 
 
  
 
 
 
  
 
 
 Обязательным условием возможности моделирования схемы является на-
личие элемента «земля», имеющего имя «0». Для этого надо с помощью инст-

румента «Земля» поместить на схему этот 
элемент (рис. 3.9), находящийся в биб-
лиотеке Source. Альтернативным реше-
нием является использование другого 
элемента «земля» с последующим при-
своением ему имени «0». 
 Для анализа схемы в переходном ре-
жиме кроме стандартных входных воз-
действий (синусоидального, прямоуголь-
ного) могут потребоваться источники 
входных воздействий (Stimulus sources), 
задаваемые пользователем. Наиболее 

простым путем создания данного источника является использование источника 
из библиотеки Sourcstm.olb (C:\Program Files\OrcadLite\Capture\Library\PSpice\ 
Sourcstm.olb), в которой представлены: 
 VSTIM – аналоговые источники напряжения;  
 ISTIM – аналоговые источники тока; 
 DIGSTIMn – источники цифровых сигналов. 
 После размещения источника на схеме с помощью правой кнопки мыши 
вызывается контекстное меню, из которого выбирается пункт Edit PSpice Stimu-
lus, после чего можно произвести редактирование входного воздействия с по-
мощью редактора Stimulus Editor. 
 После окончания ввода принципиальной схемы желательно проверить ее на 
наличие ошибок, для чего следует воспользоваться инструментом «Проверка 
правил» (см. табл. 3.2) либо выбрать пункт меню Tools → Design Rules Check. 

Пункт меню Tools и инструмент «Проверка правил» становятся доступны-
ми при активации окна менеджера проекта. 

Рис. 3.8. Редактор свойств 
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После этого на экране возникает окно, показанное на рис. 3.10.  
Для того чтобы сразу просмотреть файл 

отчета, необходимо установить флажок View 
Output. 
 Состав сведений, включаемых в отчет, вы-
бирается с помощью установки соответст-
вующего флажка в группе Report, а именно: 

Create DRC markers for warnings – созда-
ет маркеры не только для ошибок, но и для 
предупреждений; 
 Check hierarchical port connections – про-
веряет соответствие иерархических портов на 
главной и дочерней страницах схемы; 
 Check off-page connector connections – 

проверяет соответствие имен межстраничных соединителей на всех страницах 
схемы; 
 Report identical part reference – проверяет наличие идентичных ссылок на 
разные элементы; 
 Report invalid packaging – проверяет на правильность размещения элемен-
тов по корпусам; 
 Report hierarchical ports and off-page connectors – включает в файл отчета 
сведения об иерархических портах и межстраничных соединителях; 
 Check unconnected nets – проверяет наличие неприсоединенных цепей (ка-
ждая цепь обязательно должна иметь путь к «земле»), а также наличие цепей с 
одинаковыми именами; 
 Check SDT compatibility – проверяет на совместимость с Инструментами  
Разработки Схем (SDT – Schematic Design Tools). Проверка данного пункта не-
обходима при дальнейшем сохранении схемы в формате SDT; 
 Report off-grid objects – включает в отчет сведения об объектах, лежащих 
вне сетки; 

 Report all net names – включает в отчет 
сведения обо всех именах цепей.           
       Предупреждение –  сообщение, при  ко-
тором возможно (в отличие от ошибки) 
дальнейшее моделирование схемы.                         
Для конкретной  схемы в зависимости от 
логики ее работы часть предупреждений 
может игнорироваться разработчиком, 
часть должна быть обязательно учтена.  
       Кроме файла отчета информация об 
ошибках размещается на изображении 
принципиальной схемы в виде зеленого 
кружка рядом с элементом, для которого 

 

Рис. 3.10. Окно при вызове  
инструмента DRC 

 

Рис. 3.11. Матрица правил 
 проверки ошибок 
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обнаружена ошибка. Двойной щелчок на кружке выводит на экран описание 
ошибки.  
           Выбор ситуаций, которые необходимо рассматривать как ошибку либо 
выдавать предупреждение, может осуществляться пользователем с помощью 
выбора вкладки ERC Matrix в окне, изображенном на  рис. 3.10. Матрица пра-
вил проверки ошибок изображена на рис. 3.11. Выбор значка «Е» на пересече-
нии соответствующей строки и столбца (путем щелчка левой кнопкой мыши) 
приводит к рассмотрению данной ситуации как ошибки; значок «W» позволяет 
сгенерировать предупреждение. Моделирование схемы осуществляется либо с 
помощью панели инструментов (табл. 3.4), представленной на рис. 3.12, либо с 
помощью пункта меню PSpice (табл. 3.5). 

 
 
 

 

Рис. 3.12. Панель инструментов для программы PSpice 
 

Таблица 3.4  
Назначение инструментов для программы PSpice 

Пиктограмма Назначение 

 
Создает новый профиль (набор параметров) моделирования 

 
Редактирует параметры моделирования 

 
Запускает программу PSpice в режиме моделирования 

 
Позволяет просмотреть результаты моделирования 

 
Устанавливает маркер напряжения. Позволяет определить напряже-
ние в заданной точке относительно потенциала «земли» 

 
Устанавливает два маркера, между которыми определяется напряже-
ние 

 
Устанавливает маркер тока 

 
Устанавливает маркер мощности 

, ,  

Позволяет просмотреть результаты анализа цепи (напряжения, токи, 
мощности в узлах) по постоянному току. Для активации этих инстру-
ментов должен быть активирован пункт меню PSpice → Bias Points → 
Enable 

, ,  

Позволяет скрыть выделенный параметр (напряжение, ток, мощ-
ность). Для активации соответствующего инструмента должен быть 
активен инструмент «V», «I» или «W»  
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Таблица 3.5 
Команды меню PSpice 

Название Назначение 
New Simulation Profile Создает новый профиль моделирования 
Edit Simulation Profile Редактирует существующий профиль моделирования 

Run Запускает программу PSpice в режиме моделирования 
View Simulation Results Позволяет просмотреть результаты моделирования 

View Output File Позволяет просмотреть текстовый файл с результатами 
моделирования 

Create Netlist Создает текстовый файл *.net, содержащий описание 
схемы 

View Netlist Позволяет просмотреть созданное (*.net) описание схемы  
Place Optimizer Parameters  Задает параметры для программы PSpice Optimizer 

Run Optimizer Запускает программу PSpice Optimizer 

Markers Задает маркеры, отмечающие необходимые для расчета 
напряжения, токи, мощности 

Bias Points Выдает результаты расчета цепи по постоянному току 
  

          Перед началом моделирования необходимо создать профиль  (набор па-
раметров) моделирования, воспользовавшись соответствующим инструментом 
(см. табл. 3.4) либо пунктом меню (табл. 3.5), затем указать для созданного 
профиля имя. Вид анализа схемы и параметры моделирования указываются в 
окне, изображенном на рис. 3.13. 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. 3.13. Создание профиля моделирования 
 
 Вид анализа (Analysis type) может быть выбран как: 
 Time Domain (Transient) – анализ цепи во временной области (расчет пе-
реходного процесса); 
 DC Sweep – расчет цепи по постоянному току при изменении источников 
питания, параметров моделей элементов или температуры в заданных пределах; 
 AC Sweep/Noise – расчет АЧХ и ФЧХ цепи; при дополнительной активации 
раздела Noise – расчет шумовых характеристик (вклада каждого источника шу-
мов в выходной сигнал, среднеквадратичной суммы шума на выходе от дейст-
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вия всех шумовых генераторов, расчет эквивалентного входного источника 
шума); 
 Bias Point – расчет цепи по постоянному току. 
 В разделе Options кроме общих установок (General Settings), определенных 
при выборе вида анализа, можно дополнительно задать: 
 Monte Carlo/Worst Case – статистический анализ методом Монте-Карло 
либо расчет цепи на наихудший случай; 
 Parametric Sweep – изменение параметра схемы; 
 Temperature (Sweep) – температуру, при которой рассчитывается работа 
схемы и ее изменение; 
 Save Bias Points – сохранение результатов анализа схемы по постоянному 
току в отдельный файл; 
 Load Bias Points – загрузка из файла значений, определяющих режим рабо-
ты схемы по постоянному току. 
 Вид правой части окна (см. рис. 3.13) определяется выбором вида анализа и 
дополнительных параметров моделирования. Для выполнения анализа схемы 
по переменному току (расчета АЧХ и ФЧХ) необходимо указать: 
 Start Frequency – начальную частоту анализа; 
 End Frequency – конечную частоту анализа; 
 Linear – линейное изменение частоты (при необходимости) ; 
 Logarithmic – логарифмическое изменение частоты(при необходимости)  
(Decade – по декадам, Octave – по октавам); 
 Points/Decade – количество точек расчета на одну декаду; 
 Total Points – общее количество точек расчета. 
 Для обработки результатов анализа с помощью постпроцессора Probe необ-
ходимо на вкладке окна (см. рис. 3.13) выбрать закладку Probe Window и уста-
новить переключатель Display Probe window. 

Постпроцессор Probe позволяет просмотреть результаты анализа в виде 
графиков, что намного нагляднее результатов, представленных в текстовом 
файле *.out. 
После создания профиля моделирования необходимо запустить программу 

PSpice путем нажатия пиктограммы с синей стрелкой. При отсутствии ошибок 
на экране появится окно программы PSpice с результатами моделирования, 
приведенное на рис. 3.14. 
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Рис. 3.14. Результаты моделирования 

В случае когда не будет указана требуемая выходная величина, в окне ре-
зультатов моделирования отобразится только координатная сетка. Для отобра-
жения необходимого графика следует добавить его в число видимых на экране 
с помощью пункта меню Trace → Add Trace (либо щелкнув мышью на пикто-
грамме, указанной на рис. 3.14). 
 В табл. 3.6 приведено описание инструментов обработки результатов моде-
лирования, которые позволяют представить результат в наиболее удобной фор-
ме, а также провести дополнительный анализ функционирования схемы. 
 

Таблица 3.6 
Инструменты для обработки результатов моделирования 

Пикто-
грамма Назначение Выполнение  

через меню 

 
Отображает логарифмическую шкалу по оси Х Tools → Axis Settings 

 

Выполняет Фурье-анализ. Для выполнения дан-
ного пункта должен быть рассчитан переход-
ный процесс 

Trace → Fourier 

 
Позволяет сравнить характеристики семейства 
выходных сигналов 

Trace → Performance Analy-
sis 

 
Отображает логарифмическую шкалу по оси Y Tools → Axis Settings 

 
Строит график для указанной переменной Trace → Add Trace 

 
Вычисляет целевую функцию Trace → Eval Goal Function 
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Окончание табл. 3.6 

Пикто-
грамма Назначение Выполнение  

через меню 

 
Вставляет текстовую метку Plot → Label → Text 

 
Помечает рассчитанные точки — 

 
Включает отображение курсора. Является 
удобным средством для измерений  по графику Trace → Cursor → Display 

3.3. Моделирование функциональных схем 
 С помощью программ Capture-PSpice электрические схемы можно модели-
ровать не только на уровне принципиальной схемы, но также и на уровне 
функциональной, что является удобным средством на этапе предварительного 
определения параметров каждого блока устройства. 
 Для моделирования схемы на функциональном уровне необходимо исполь-
зовать библиотеку АВМ (Analog Behavioral Modeling), расположенную по адре-
су C:\Program Files\OrcadLite\Capture\Library\PSpice\abm.olb. 
 Весь набор элементов этой библиотеки можно разбить на два подмножест-
ва: элементы систем управления и PSpice-эквивалентные элементы. Элементы 
систем управления имеют один вход и один выход. Предполагается, что вход-
ные (выходные) сигналы этих элементов действуют между входом (выходом) 
элемента и «землей», при этом вид используемого сигнала (ток, напряжение 
и т. д.) безразличен. PSpice-эквивалентные элементы отражают структуру 
управляемых источников тока (G) и напряжения (Е), используемых в програм-
ме PSpice, и имеют дифференциальный вход и симметричный выход. Описания 
элементов библиотеки АВМ приведены в табл. 3.7 и 3.8. 
 

Таблица 3.7 
Элементы систем управления 

Категория Элемент Описание Параметры 

Основные 
компоненты 

CONST Константа VALUE  
SUM Сумматор  
MULT Умножитель  
GAIN Усилитель GAIN 
DIFF Вычитание  

Ограничители 

LIMIT Ограничитель LO, HI 
GLIMIT Усилитель-ограничитель LO,HI,GAIN 

SOFTLIM «Мягкий» усилитель-
ограничитель LO,HI,GAIN 
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Продолжение табл. 3.7 
Категория Элемент Описание Параметры 

Фильтры 
Чебышева 

LOPASS Фильтр нижних частот FP, FS, RIPPLE, STOP 
HIPASS Фильтр верхних частот FP, FS, RIPPLE, STOP 
BANDPASS Полосовой фильтр FP, FS, RIPPLE, STOP 
BANDREJ Режекторный фильтр FP, FS, RIPPLE, STOP 

Интегратор и 
дифференциатор 

INTEG Интегратор GAIN, IC 
DIFFER Дифференциатор GAIN 

Передаточная 
функция от ком-
плексной пере-

менной s 

LAPLACE Элемент, задаваемый 
передаточной функцией 
от комплексной пере-
менной s 

NUM, DENOM 

Таблицы 
соответствия 

TABLE Элемент, задаваемый 
таблицей: входное на-
пряжение – выходное 
напряжение 

ROW1…ROW5 

FTABLE Элемент, задаваемый 
таблицей: частота вход-
ного сигнала – ослабле-
ние в дБ – фаза 

ROW1…ROW5 

Математические 
функции 

ABS x   

SQRT x   
PWR EXPx  EXP 

PWRS EXPx  EXP 
LOG ln(x)  
LOG10 log(x)  
EXP ex  
SIN, COS, 
TAN 

sin(x), cos(x), tan(x)  

ATAN, 
ARCTAN 

Tan–1(x)  

Функции 
пользователя 

ABM Элемент без входа и с 
одним выходом по на-
пряжению 

EXP1..EXP4 

 
ABM1 

Элемент с одним входом 
и одним выходом по на-
пряжению 

EXP1..EXP4 

 
ABM2 

Элемент с двумя входа-
ми и одним выходом по 
напряжению 

EXP1..EXP4 

 
ABM3 

Элемент с тремя входа-
ми и одним выходом по 
напряжению 

EXP1..EXP4 

 ABM/I Элемент без входа и од-
ним токовым выходом  EXP1..EXP4 

 ABM1/I Элемент с одним входом 
и токовым выходом EXP1..EXP4 
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Окончание табл. 3.7 
Категория Элемент Описание Параметры 

 ABM2/I Элемент с двумя входа-
ми и токовым выходом EXP1..EXP4 

 ABM3/I Элемент с тремя входа-
ми и токовым выходом EXP1..EXP4 

 
В табл. 3.7 использованы следующие обозначения параметров: 
VALUE – значение; 
GAIN – коэффициент усиления (в разах); 
LO – нижний уровень; 
HI – верхний уровень; 
FP – граничная частота полосы пропускания; 
FS – граничная частота полосы задерживания; 
RIPPLE – неравномерность АЧХ в полосе пропускания (в дБ); 
STOP – затухание в полосе задерживания (в дБ); 
F0, F1, F2, F3 – частоты среза; 
IC – начальное значение; 
NOM – числитель; 
DENOM – знаменатель; 
ROW – строка; 
EXP – арифметическое выражение. 

Аргументы тригонометрических функций должны быть указаны в ра-
дианах. 

 PSpice-эквивалентные элементы могут быть классифицированы как прибо-
ры E- и G- типов. Так как передаточные функции данных элементов могут со-
держать произвольную комбинацию входных токов и напряжений, то тип ис-
пользуемого элемента определяется только необходимым выходным сигналом 
(током или напряжением). 
 На языке моделирования описание PSpice-эквивалентного элемента имеет 
следующий вид: 

E <name> <connecting nodes> <ABM keyword> <ABM function>, 
где name – имя устройства; 
       connecting nodes – узлы подключения; 
       ABM keyword – определяет вид используемой передаточной функции, а 
именно: 
   VALUE – арифметическое выражение; 
   TABLE – таблица соответствия; 
   LAPLACE – функция комплексной переменной s; 
   FREQ – таблица соответствия в частотной области; 
   CHEBYSHEV – характеристика фильтра Чебышева; 
    ABM function – описание передаточной функции в виде формулы либо 
таблицы соответствия. 

Би
бл
ио
те
ка

 БГ
УИ
Р



  31

Пример: рассмотрим умножитель, имеющий четыре входа и два выхода. 
Его описание имеет вид 

E^@REFDES %OUT+ %OUT – VALUE {V(%IN1+,%IN1 –)*V(%IN2+,%IN2 –)}. 
 

Таблица 3.8 
PSpice-эквивалентные элементы 

Категория Элемент  Описание Параметры 

Математические 
выражения 

EVALUE, 
GVALUE Функция EXPR 

ESUM, 
GSUM Сумматор — 

EMULT, 
GMULT Умножитель — 

Таблица 
соответствия 

ETABLE, 
GTABLE Таблица соответствия EXPR, TABLE 

EFREQ, 
GFREQ 

Таблица: входная часто-
та – выходное напряже-
ние (ток) 

EXPR, TABLE 

Передаточная 
функция от ком-
плексной пере-

менной s 

ELAPLACE, 
GLAPLACE 

Элемент, задаваемый 
передаточной функцией 
от комплексной пере-
менной s 

EXPR, XFORM 

 
 В табл. 3.8 использованы следующие обозначения параметров: 
 EXPR – математическая функция от двух (в отличие от EXP) входных сиг-
налов; 

TABLE – таблица; 
XFORM – функция от комплексной переменной s. 

Пример: EXPR = 15ma*SIN(6.28*10kHz*TIME+V(%IN+,%IN –)); 
    TABLE = (0, 0) (.02, 2.690E – 03) (.04, 4.102E – 03) (.06, 4.621E – 03); 

              XFORM = 1/(1+.001*s). 
 

4. ПРОГРАММА PSPICE 
4.1. Алгоритм подготовки схемы к моделированию 

 Для запуска программы PSpice без запуска программы Capture необходимо 
выбрать следующие пункты меню «Пуск»: Пуск → Программы → Orcad Fami-
ly Release 9.2 Lite Edition → PSpice AD Lite Edition. 
 В появившемся на экране окне программы необходимо создать новый тек-
стовый файл, используя команды меню «File» (File → New → Text File). 
В появившемся окне нового документа необходимо набрать текст программы 
на языке моделирования. 
 После ввода схемы необходимо сохранить файл на диск в виде  <имя фай-
ла>.cir. После этого необходимо закрыть созданный текстовый файл и открыть 
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файл в формате описания схемы (*.cir). После выполнения указанных действий 
на панели инструментов появляется синяя стрелка, щелчок на которой запуска-
ет процесс моделирования. 
 

4.2. Входной язык 
В программе SPICE информация о схеме и необходимых видах и параметрах 

анализа задается во входном текстовом файле, который формируется в соответ-
ствии со входным языком. 

Формат входного языка свободный, т. е. нет жестких требований к последо-
вательности записи входной информации. В качестве разделителей для полей 
записей используются пробел(ы), запятая, знак равенства или левая и правая 
скобки. Пробелы в записи, не используемые в качестве разделителей, игнори-
руются. Любая запись может быть перенесена на следующую строку, для чего в 
начале строки необходимо поместить знак плюс. Поле имени в записи должно 
начинаться с буквы латинского алфавита (A–Z) и не может содержать перечис-
ленные выше разделители. Информационные поля могут быть целочисленны-
ми, с плавающей точкой, могут использовать экспоненциальную форму или со-
провождаться следующими масштабными коэффициентами: 

Т = 1Е12;  G = 1E9;  MEG = 1E6; K = 1E3; 
М = 1Е-3;  U = 1E-6;   N = 1E-9;   P = 1E-12;  F = 1E-15. 
Символы, следующие сразу за числом и не являющиеся масштабными ко-

эффициентами, игнорируются. Например: 
1000 = 1000.0 = 1000HZ = 1E3 = 1.0Е3 = 1КНZ = 1К = 0.001MEGHZ. 
Существует два типа записей: 
1) записи описания элементов схемы; 
2) управляющие записи, или директивы управления.  
Первый тип записей определяет топологию схемы, ее состав и значения 

элементов. Второй тип записей управляет работой программы и задает пара-
метры моделей элементов. 

Первая запись во входном файле всегда является заголовком. Последняя 
должна быть всегда директивой [.END]. Порядок остальных записей произ-
вольный. 

Отсутствие заголовка приводит к тому, что первая строка описания схемы 
исключается из рассмотрения, что приводит к ошибке. 

Каждый элемент схемы описывается записью, которая содержит имя эле-
мента, узлы подключения элемента и параметры, определяющие его электриче-
ские характеристики. Первая буква в имени элемента задает его тип. 
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Номерами узлов схемы должны быть произвольные целые неотрицательные 
числа. Узел, соответствующий «земле», имеет номер ноль и должен обязатель-
но присутствовать в описании схемы. 

Токи в ветвях схемы всегда направлены по уменьшению напряжения. Схема 
не может содержать контуров из источников напряжения и (или) индуктивно-
стей, а также сечений из источников тока и (или) емкостей. К каждому узлу в 
схеме должны быть подключены по крайней мере две ветви (за исключением 
конечных  узлов линии  с  распределенными  параметрами  и  узлов  подложки  
МОП-транзисторов). Любой узел должен иметь путь по постоянному току к 
«земле». 

Входной язык позволяет вставлять записи с комментариями в любое место 
входного файла. Строка с комментарием должна начинаться с символа «*». При 
добавлении комментария в конец строки используется символ «;». 

Напишем программу для расчета амплитудно-частотной характеристики  
(АЧХ)  схемы,  представленной   на   рис. 4.1,  с  параметрами  R = 50 Ом, 

     L = 0,25 Гн, C = 2 мкФ: 
PRIMER 
R 1 2 50 
L 2 3 0.25 
C 3 0 2U 
VIN 1 0 AC 1 
.AC LIN 100 30 300 
.PLOT AC V(3) 
.PROBE 
.END 

Отметим, что в схеме обязательно должен присутствовать источник, тип 
которого определяется требуемым видом анализа схемы. 

Директива .PROBE служит для запуска постпроцессора, позволяющего 
представить результаты моделирования в графическом виде. 
 Подробное описание элементов схемы и директив управления приведено 
ниже. 

4.3. Описание элементов электронных схем 
Для задания структуры электронной схемы применяются записи с описа-

ниями элементов, которые содержат информацию об узлах подключения и зна-
чениях параметров моделей. Рассмотрим составление данных записей более 
подробно. 

4.3.1. Резисторы:  
Rимя N1 N2 <Имя модели> [Номинал], 

где  R – идентификатор резистора; 
имя – позиционное обозначение элемента в схеме; 
N1, N2 – узлы подключения резистора (положительное направление тока 

через резистор от N1 узла к узлу N2); 

 

R L

UС
U С 

1 2 3 

0 
Рис. 4.1. Схема примера 
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Номинал – величина сопротивления резистора (может быть положительной, 
отрицательной, но не нулевой). В случае необходимости в нулевом сопротив-
лении необходимо ввести значение, много меньшее других сопротивлений в 
схеме (например 1Е-6). 

Имя модели – имя модели, описывающей зависимость сопротивления от 
температуры. 

Параметры модели резистора приведены в табл. 4.1. 
Примечание. В дальнейшем между символами “<” и  “>” будем размещать 

необязательные параметры. 
Таблица 4.1 

Параметры модели резистора 

Параметр Коэффициенты Ед. изм. Значение по умол-
чанию 

R Масштабный – 1 

ТС1 Линейный температурный 1/оC 0 

TC2 Квадратичный  
температурный 1/оC2 0 

ТСЕ Экспоненциальный  
температурный 1/оC 0 

T_ABS Абсолютная температура оC 27 

T_MEASURED Температура измерений оC 27 

T_REL_GLOBAL Относительная температура оC 0 

T_REL_LOCL Разность между температурой ре-
зистора и модели-прототипа 

оC 0 

 
Описание модели резистора в общем случае имеет следующий вид:  

.MODEL [Имя модели] RES <R=3H1> <ТС1=3Н2> <ТС2=3НЗ>, 
где  Имя модели  –  имя модели резистора; 
        ЗН1, ЗН2, ЗНЗ – значения параметров. 

Параметрам, не указанным в описании модели, присваиваются значения по 
умолчанию. Если модель не задана, то значение сопротивления резистора при-
нимается равным номиналу. Если в модели не указан параметр ТСЕ, то величи-
на сопротивления резистора r определяется по формуле 

r = Hoминал * R *[l+(T – T0)*TC1+(T – T0)2 
* TC2]. 

В случае, если параметр ТСЕ задан, то величина сопротивления резистора r 
определяется как 

r = Номинал * R * 1.01TCE*(T – T0). 
R1 15 0 2К 
*Резистор R1, включенный между узлами 15 и 0 номиналом 2 КОм 
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     RG 1 2 mod_my 2E2. 
          *Резистор RG, включенный между узлами 1 и 2, имеющий номинал 
*200 Ом и описываемый моделью mod_my. 

4.3.2. Конденсаторы:  

Симя Nl N2 <Имя модели> [Номинал] <IС>, 
где С – идентификатор конденсатора; 

имя – обозначение элемента на схеме; 
      N1,N2   – узлы подключения конденсатора; 
      Номинал– величина емкости конденсатора (может быть положительной, от-
рицательной,  но не нулевой); 

IС – начальное значение напряжения на конденсаторе. 
Параметры модели конденсатора приведены в табл. 4.2 

Таблица 4.2 
Параметры модели конденсатора 

Параметр Коэффициенты Ед. изм. Значение по умол-
чанию 

С Масштабный – 1 

VС1 При линейной части  
VC 1/V 0 

VC2 При квадратичной части VC  1/V2 0 

ТС1        Линейный температурный  1/оC 0 

ТС2 Квадратичный температурный 1/оC2 0 

T_ABS Абсолютная температура оC 27 

T_MEASURED Температура измерений оC 27 

T_REL_GLOBAL Относительная температура оC 0 

T_REL_LOCL Разность между температурой 
конденсатора и модели-прототипа 

оC 0 

Описание модели конденсатора в общем случае имеет следующий вид:  
.MODEL [Имя] CAP <П1 = ЗН1> <П2 = ЗН2> ....... , 

где Имя – имя модели; 
П1,П2,… – наименования параметров; 

      ЗН1,ЗН2,… – значения параметров. 
Параметрам, не указанным в описании модели, присваиваются значения по 

умолчанию. Если модель не задана, то величина емкости конденсатора прини-
мается равной номиналу. 

 Если модель задана, то значение емкости определяется по формуле 
С = ( Номинал*С)*(l+VC*VC1+VC2

*VC2)*[l+(T–TO)*TC1+(T–TO)2 
*TC2]. 
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Задание начального напряжения на конденсаторе позволяет уменьшить 
время расчета переходного процесса. 

CLOAD 15 0 20PF 
С2 1 2.2Е – 12 IC=15V 
CFDB 3 4 CMOD 10PF 

4.3.3. Индуктивности: 
Lимя  Nl  N2 <Имя модели> [Номинал] <IС>, 

где   L – идентификатор индуктивности; 
        имя – обозначение элемента на схеме; 
        Nl, N2 – узлы подключения индуктивности; 
        Номинал – величина индуктивности (может быть положительной, отрица-
тельной, но не нулевой); 
        IС – начальный ток через индуктивность. 

Параметры модели индуктивности приведены в табл. 4.3. 
Таблица 4.3 

Параметры модели катушки индуктивности 

Параметр Коэффициенты Ед. изм. Значение  
по умолчанию 

L Масштабный – 1 

IL1 Линейный по току 1/А 0 

IL2 Квадратичный по току 1/А2 0 

ТС1 Линейный температурный 1/C 0 

ТС2 Квадратичный температурный 1/C2 0 

Описание модели индуктивности в общем случае имеет  следующий вид: 
.MODEL [Имя] IND <П1 = ЗН1> <П2 = ЗН2> .......  , 

где Имя –  имя модели; 
П1, П2… – наименования параметров; 

      ЗН1, ЗН2 … –  значения параметров. 
Параметрам, значения которых не указаны в описании модели, присваива-

ются значения по умолчанию. Если модель не задана, то значение индуктивно-
сти принимается  равным номиналу. Если модель задана явно, то значение ин-
дуктивности определяется по формуле 

L = (НоминалL)(1+IIL1+I2IL2)[1+(T – T0) 2TC2]. 
Задание начального тока через индуктивность позволяет уменьшить время 

расчета переходного процесса. 
LL0AD  15  0  20MH 
L1  2  3  LMOD  0.3 
Lbm2 4 7  Lmod 1m IC =  0.1 
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4.3.4. Взаимные индуктивности (трансформаторы): 
Кимя Lxxx Lyyy Ксв, 

где    К – идентификатор взаимной индуктивности (трансформатора); 
          имя – обозначение элемента на схеме; 
          ххх, ууу – имена индуктивностей на схеме, между которыми имеется вза-
имная связь; 
          Ксв – коэффициент связи (– 1<Ксв<1). 

Коэффициент связи можно определить, зная индуктивности катушек и их 
взаимную индуктивность, по формуле 

св 1 2
MK

L L



.  

Пример: 
KTR  L1  L2  0.1 
L1  2  3  1 
L2  5  6  0.5 

Примечание. Начало обмотки помещается в первый узел индуктивности. 
Полярность определяется только последовательностью узлов в описании ин-
дуктивностей и не зависит от порядка описания индуктивностей в записи «К». 
Если трансформатор состоит из нескольких обмоток, то в записях «К» нужно 
перечислить все взаимосвязанные пары.  

Например, трансформатор со средним отводом от первичной обмотки и с 
двумя вторичными обмотками описывается так: 

*Первичная   обмотка     *Взаимная     связь 
L1     1     2     100UH      K12    L1    L2     .9999  
L2     2     3     100UH      K13    L1    L3     .9999  
  
*Вторичная    обмотка    K14    L1    L4    .9999 
L3    11    12     100UH     K23    L2    L3     .9999  
L4    13    14     100UH     K24    L2    L4     .9999  
K34    L3    L4     .9999 

 
               4.3.5. Магнитный сердечник трансформатора: 

Кимя Lxxx Lyyy Ксв <имя модели> <масштабный коэффициент>, 
где    Кимя – идентификатор сердечника; 
          имя – обозначение элемента на схеме; 
          ххх, ууу – имена индуктивностей, расположенных на сердечнике; 
          Ксв – коэффициент связи. 

Все обмотки имеют одинаковый коэффициент связи. При описании каждой 
обмотки, упомянутой в составе сердечника, необходимо указывать не  индук-
тивность, а число витков обмотки сердечника. 
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Параметр <масштабный коэффициент> – изменяет площадь поперечного 
сечения магнитопровода (по умолчанию равен единице), которая равна произ-
ведению этого коэффициента на параметр модели сердечника AREA. Парамет-
ры модели для LEVEL = 2 приведены в табл. 4.4. 

Существуют два уровня этой модели: LEVEL = 1 и LEVEL = 2, из которых 
модель LEVEL = 1 оказалась неудачной и в последних версиях PSpice была ис-
ключена. В программе PSpice используется модель Джилса и Атерна, основан-
ная на представлении движения доменных границ магнитных материалов. Она 
отражает следующие основные характеристики гистерезиса: кривую начальной 
намагниченности, намагниченность насыщения, коэрцитивную силу и остаточ-
ную намагниченность. 

Параметры AREA, PATH, GAP, PACK определяются геометрическими па-
раметрами сердечника, остальные – свойствами магнитного сердечника. 

   

Таблица 4.4 
Параметры модели сердечника 

Параметр Описание Ед. изм. Значение по умол-
чанию 

LEVEL Индекс модели – 2 

A Параметр формы безгистерезисной 
кривой намагниченности А/м 1000 

AREA Площадь поперечного сечения маг-
нитопровода см2 0.1 

C Постоянная упругого смещения до-
менных границ – 0.2 

GAP Ширина воздушного зазора см 0 

K Постоянная подвижности доменов А/м  500 

MS Намагниченность насыщения А/м 106 

PACK Коэффициент заполнения сердеч-
ника – 1 

PATH Средняя длина магнитной 
 силовой линии см 1 

Описание модели сердечника в общем случае имеет  следующий вид: 
.MODEL [Имя] CORE <П1 = ЗН1> <П2 = ЗН2> .......  , 

где Имя –  имя модели; 
П1, П2… – наименования параметров; 

      ЗН1, ЗН2 … –  значения параметров. 
 

4.3.6. Линии передачи: 
Тимя Х1+ Х2 – Х3+ Х4- ZO <TD>  <F>  <NL> , 

где    Т – идентификатор линии передачи; 
   имя – обозначение элемента на схеме; 
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   Х1, Х2 – узлы подключения на первой паре; 
   Х3, Х4 – узлы подключения на второй паре; 
   ZO  –   характеристическое сопротивление; 
   TD  –   время задержки в секундах; 
   F – частота в герцах; 
   NL – длина волны на частоте F. 

Примечание. (+) и (–) вывода позволяют определить направление тока (от 
(+) к (–)). По умолчанию NL = 0,25. 

TDELAY  15  0  16  0  ZO = 5000HM  TD = 0.2NS 
T33  4.2  3  5  ZO = 220  F = 2.25MEGHZ 

4.3.7. Идеальные управляемые ключи: 
Sимя  N1  N2  N3+  N4-  [Имя модели], 

где S – идентификатор ключа; 
имя – обозначение элемента на схеме; 
N1, N2 – узлы подключения контактов ключа; 

  N3, N4 – положительный N3 и отрицательный N4 узлы подключения 
управляющего источника напряжения (тока). 

Параметры модели ключа приведены в табл. 4.5. 
Таблица 4.5 

Параметры модели управляемого ключа 

Параметр Значение параметра Ед. изм. Значение 
по умолчанию 

VON Напряжение открывания В –  

VOFF  Напряжение закрывания В –  

ION  Ток открывания А –  

IOFF Ток закрывания А –  

RON Сопротивление открытого ключа Ом 1 

ROFF Сопротивление закрытого ключа Ом 106 

Описание модели идеального ключа имеет следующий вид: 
.MODEL  [Имя]  [ТИП]  <П1 = ЗН1>  <П2 = ЗН2>  …. , 

где Имя – имя модели; 
ТИП –  один из следующих типов: 

VSWITCH – модель ключа, управляемого напряжением, 
       ISWITCH – модель ключа, управляемого током; 
П1, П2...–  наименования параметров; 
ЗН1, ЗН2...–  значения параметров. 
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Параметрам, значения которых не указаны в описании модели, присваива-
ются значения по умолчанию. 

При напряжениях (токах), находящихся в диапазоне между порогом откры-
вания и порогом закрывания, сопротивление ключа изменяется в пределах 
ROFF и RON. Сопротивление утечки по входу управления 1Е12 Ом. 

Sbw2  15  2  3  О  ТТТ  
.MODEL  ТТТ  VSWITCH  Von = 2  Voff = l 

4.3.8. Полупроводниковые диоды: 
Dимя  N+  N – [Имя модели]    <area> , 

где D – идентификатор диода; 
имя – обозначение элемента на схеме; 
N+ –  узел подключения положительного вывода диода (анода); 
N-  –  узел подключения отрицательного вывода диода (катода); 
Имя модели –  имя модели диода; 
area –  относительное значение площади прибора (по умолчанию 1,0). 
Параметры модели диода приведены в табл. 4.6. 
 

Таблица 4.6 
Параметры модели диода 

Параметр Описание Ед. изм. Значение 
по умолчанию 

AF 
 

Показатель степени в формуле 
фликер-шума – 1 

BV 
 

Обратное напряжение пробоя  
(положительная величина) В ∞ 

CJO 
 

Барьерная емкость 
при нулевом смещении Ф 0 

EG 
 Ширина запрещенной зоны эВ 1.11 

IBV 
 

Начальный ток пробоя, соответст-
вующий 

напряжению BV  
(положительная величина) 

А 10–10 

IBVL 
 

Начальный ток пробоя  
низкого уровня А 0 

IKF 
 

Предельный ток при высоком 
уровне инжекции А ∞ 

IS Ток насыщения при Т = 27°С А 10–14 

ISR Ток рекомбинации А 0 

NR Коэффициент эмиссии для тока ISR – 2 

RS Объемное сопротивление Ом  0 

TRS1 Линейный температурный коэффи-
циент RS 1/C 0 
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Окончание табл. 4.6 
Параметр Описание Ед. изм. Значение 

по умолчанию 

TRS2 Квадратичный температурный коэф-
фициент RS 1/оC2 0 

ТТ Время переноса заряда с 0 

VJ Контактная разность потенциалов В 1 

XTI Температурный коэффициент тока 
насыщения – 3 

T_ABS Абсолютная температура оC 27 

T_MEASURED Температура измерений оC 27 

T_REL_GLOBAL Относительная температура оC 0 

T_REL_LOCL Разность между температурой диода 
и модели-прототипа 

оC 0 

 
Описание модели диода выглядит следующим образом: 

.MODEL [Имя] [Тип] <П1 = ЗН1> <П2 = ЗН2> ..., 
где Имя –  имя модели; 

Тип  –  D для плоскостного диода; 
П1, П2...–  наименования параметров; 
ЗН1, 3Н2...–  значения параметров. 

D1 14  0  DMOD 
.MODEL DMOD D 

4.3.9. Биполярные транзисторы: 
Qимя NC NB NЕ [Имя модели] <агеа>, 

 где Q – идентификатор биполярного транзистора; 
имя –  обозначение элемента на схеме; 
NC, NB, NE – узлы подключения коллектора, базы, эмиттера биполярного 

транзистора соответственно;  
Имя модели –  имя модели транзистора; 
area –  относительное значение площади прибора (по умолчанию 1,0). 
Примечание. При анализе по постоянному току используется модель Гумеля –

Пунна, а  в  случае отсутствия ряда параметров этой модели используется модель 
Эберса – Молла.  

Описание модели биполярного транзистора выглядит следующим образом: 
.MODEL  [Имя]  [Тип]  <П1 = ЗН1>  <П2 = ЗН2> ...., 

где Имя –  имя модели; 
Тип –  один из следующих типов: 

NPN – модель транзистора с проводимостью n-типа,  
PNP – модель транзистора с проводимостью p-типа; 
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П1, П2... –  наименования параметров; 
ЗН1, 3Н2... –  значения параметров. 
Параметры модели биполярного транзистора приведены в табл. 4.7. 

Таблица 4.7 
Параметры модели биполярного транзистора 

Параметр Описание Ед. изм. Значение 
по умолчанию 

AF 
 

Показатель степени  
в формуле фликер-шума – 1 

BF 
 

Коэффициент передачи тока  
в нормальном режиме в схеме с ОЭ – 100 

BR Коэффициент передачи тока 
в инверсном режиме в схеме с ОЭ – 1 

CJC 
 

Емкость коллекторного перехода 
при нулевом смещении Ф 0 

CJE Емкость эмиттерного перехода 
при нулевом смещении пФ 0 

CJS Емкость коллектор – подложка  
при нулевом смещении Ф 0 

EG 
 Ширина запрещенной зоны эВ 1.11 

FC 
Коэффициент нелинейности 

барьерных емкостей 
прямосмещенных переходов 

– 0,5 

IKF 
 

Ток начала спада зависимости BF 
от тока коллектора  

в нормальном режиме 
А ∞ 

IKR 
 

Ток начала спада зависимости BF от 
тока эмиттера в инверсном режиме А ∞ 

IRB 
Ток базы, при котором cопроти-

вление базы уменьшается на 50 % 
полного перепада между RB и RBM 

А ∞ 

IS Ток насыщения при Т = 27 °С А 10–15 

ISC Ток насыщения утечки перехода 
база – коллектор А 0 

ISE Ток насыщения утечки перехода 
база – эмиттер А 0 

ISS Обратный ток перехода подложки А 0 

KF Коэффициент, определяющий спек-
тральную плотность фликер-шума – 0 

PTF Дополнительный фазовый сдвиг на 
граничной частоте транзистора град 0 

RB Объемное сопротивление базы при 
нулевом смещении база – эмиттер Ом 0 

RBM Минимальное сопротивление базы 
при больших токах Ом RB 

RC Объемное сопротивление коллектора Ом 0 
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Окончание табл. 4.7 

Параметр Описание Ед. изм. Значение 
по умолчанию 

RE Объемное сопротивление эмиттера Ом 0 

TF Время переноса заряда через базу 
в нормальном режиме с 0 

TR Время переноса заряда через базу 
в инверсном режиме  с 0 

TRB1 Линейный температурный 
коэффициент RB 1/оC 0 

TRB2 Квадратичный температурный 
коэффициент RB 1/оC2 0 

TRC1 Линейный температурный 
коэффициент RC 1/оC 0 

TRC2 Квадратичный температурный 
коэффициент RC 1/оC2 0 

TRE1 Линейный температурный 
коэффициент RE 1/оC 0 

TRE2 Квадратичный температурный 
коэффициент RE 1/оC2 0 

TRM1 Линейный температурный 
коэффициент RM 1/оC 0 

TRM2 Квадратичный температурный 
коэффициент RM 1/оC2 0 

VAF Напряжение Эрли  
в нормальном режиме В ∞ 

VAR Напряжение Эрли 
в инверсном режиме В ∞ 

VJC Контактная разность потенциалов 
перехода база – коллектор В 0,75 

VJE Контактная разность потенциалов 
перехода база – эмиттер В 0,75 

VJS Контактная разность потенциалов 
перехода коллектор – подложка В 0,75 

VTF 
Напряжение, характеризующее 
зависимость TF от смещения 

база – коллектор 
В ∞ 

XTB Температурный коэффициент 
BF и BR – 0 

XTI Температурный коэффициент IS – 3 

T_ABS Абсолютная температура оC 27 

T_MEASURED Температура измерений оC 27 

 

Би
бл
ио
те
ка

 БГ
УИ
Р



  44

Пример:            Q1  14  2  13  KT3102A 
                  .MODEL KT3102A NPN (BF = 500) 

4.3.10. Полевые транзисторы с изолированным затвором 
(МОП-транзисторы) (MOSFET): 
М имя ND NG NS NB [Имя модели] <L = [valL]> <W = [valW]> 

 +<AD = [valAD]> <AS = [valAS]> <PD = [valPD]> <PS = [valPS]> 

+ <NRD = [valNRD]> <NRS = [valNRS]>, 

где М –  идентификатор МОП-транзистора; 
имя –  обозначение элемента на схеме; 

      ND, NG, NS –  узлы подключения соответственно стока, затвора, истока 
МОП-транзистора; 

NB –  узел подключения подложки; 
Имя модели –  имя модели транзистора; 
valL – длина канала (может устанавливаться пользователем); 
valW – ширина канала (может устанавливаться пользователем); 
valAD – площадь стока, в метрах; 
valAS – площадь истока, в метрах; 
valPD – периметр стока, в метрах; 
valPS – периметр истока, в метрах; 
valNRD – относительное сопротивление стока; 
valNRS – относительное сопротивление истока. 
Описание модели МОП-транзистора в общем случае имеет вид 

.MODEL  [Имя]  [Тип]  <П1 = ЗН1>  <П2 = ЗН2> ...., 
где Имя – имя модели; 
       Тип –  один из следующих типов: 
              NMOS – модель МОП-транзистора с каналом n-типа, 
              PMOS – модель МОП-транзистора с каналом p-типа; 

П1,П2... – наименования параметров; 
      ЗН1,ЗН2... – значения параметров. Параметрам, не указанным в описа-

нии модели, присваиваются значения по умолчанию. 
Ml   14   2   13   0  PNOM  L = 25U W = 12U 
M2A 0 2 100 100 NW L = 33U  W = l2U AD = 288P AS = 288P  PD = 60U 

4.3.11. Полевые транзисторы с управляющим р-n-переходом: 
Jимя  ND  NG  NS [Имя модели] [area], 

где  J – идентификатор полевого транзистора с управляющим р-n-переходом; 
имя – обозначение элемента на схеме; 
ND, NG, NS – узлы подключения стока, затвора и истока полевого транзи-

стора соответственно; 
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Имя модели – имя модели транзистора; 
area – относительное значение площади прибора (по умолчанию 1,0). 
Описание модели полевого транзистора с управляющим р-n-переходом в 

общем случае имеет следующий вид: 
.MODEL  [Имя]  [Тип]  <П1 = ЗН1>  <П2 = ЗН2> ... , 

где Имя – имя модели; 
Тип – один из следующих типов: 
NJF – модель полевого транзистора с каналом типа n. 
PJF – модель полевого транзистора с каналом типа р; 
П1, П2... – наименования параметров;  
ЗН1, ЗН2... – значения параметров. Параметрам, не указанным в описании 

модели, присваиваются значения по умолчанию. 

J13   22 14  23  JNOM  2.0 
 

4.3.12. Транзисторы на основе арсенида галлия (GASFET): 
В имя  ND  NG  NS  [Имя модели] < Коэфф. кратности area>, 

где В – идентификатор транзистора на основе арсенида галлия; 
     имя – обозначение элемента на схеме; 
     ND, NG, NS – узлы подключения  стока, затвора и истока полевого тран-
зистора соответственно; 

Имя модели – имя модели транзистора. 
Описание модели транзистора на основе арсенида галлия в общем случае 

имеет следующий вид: 
.MODEL  [Имя]  [Тип]  <П1=ЗН1>  <П2=ЗН2> .... 

где Имя – имя модели; 
Тип – GASFET-модель транзистора на основе арсенида галлия с n-каналом; 
П1,П2... – наименования параметров; 
ЗН1,ЗН2... – значения параметров. Параметрам, не указанным в описании 

модели, присваиваются значения по умолчанию. 
BIN  100   1   О   GFAST 
В13   22   14   23  GNOM  2.0 

4.3.13. Независимые источники тока и напряжения: 
Vимя  N+ N – <DC [ЗН1]>  <AС [ЗН2] <ФАЗА>>  <ТЗАК> <ПАРАМЕТРЫ>, 
Iимя N+ N – <DC [3H1]>  <АС [ЗН2] <ФАЗА>>  <ТЗАК> <ПАРАМЕТРЬ1>, 

где V (I) – идентификатор источника напряжения (тока); 
имя – обозначение источника на схеме; 
N+, N- – соответственно положительный и отрицательный узлы подключения 

источника (ток течет от положительного узла через источник к отрицательному); 
DC – обозначение источника постоянного напряжения (тока); 
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ЗН1 – номинальное значение источника в вольтах (амперах); 
АС – обозначение источника переменного (синусоидального) напряжения 

(тока) для частотного анализа; 
ЗН2 – амплитуда сигнала в вольтах (амперах); 
ФАЗА – фаза переменной составляющей в градусах (если эта величина не 

задана, то она принимается равной нулю); 
ТЗАК – закон, по которому изменяется напряжение или ток источника во 

времени. Применяется при анализе переходного процесса. Может быть задан 
один из следующих законов: 

PULSE – для источника трапецеидальных импульсов; 
ЕХР – для источника экспоненциальных импульсов; 
SIN – для источника синусоидального напряжения; 
PWL – для кусочно-линейного источника; 
SFFN – для амплитудно-модулированного источника; 

ПАРАМЕТРЫ – параметры источника во временной области (свои для каж-
дого конкретного источника) задаются. 

4.3.13.1. Источник трапецеидальных импульсов: 

PULSE (V1 V2 TD TR TF PW PER), 
PULSE (I1  I2   TD ТR TF PW PER), 

где PULSE – идентификатор импульсного источника; 
V1 (I1) – постоянная составляющая, в вольтах (амперах); 
V2 (I2) – максимальное значение сигнала, в вольтах (амперах); 
TD – время задержки в секундах (по умолчанию равно 0); 
TR – длительность переднего фронта импульса, (по умолчанию равна 

TSTEP); 
TF – длительность заднего фронта импульса, в секундах (по умолчанию 

равна TSTEP); 
PW – длительность вершины импульса, в секундах (по умолчанию равна 

TSTEP; 
PER – период импульса, в секундах (по умолчанию равен TSTOP). 
Перечисленные параметры пояснены на рис. 4.2. 
 
 
 

 
 
 
 
 
 

 
 

TD TR TF PW 

T 

V1 

V2 

t 

V 

Рис. 4.2. Параметры источника трапецеидальных импульсов 
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Примечание. TSTEP – приращение времени при расчете переходного 
процесса; 

TSTOP – конечная временная точка при расчете переходного процесса. 
VIN  100  0  PULSE (0 5 0 0 0 1 2); источник прямоугольных импульсов с  
* амплитудой 5В, длительностью вершины 1с и периодом 2с 
VIN  100  0  PULSE (0 5 0 1 1 0 2); источник треугольных импульсов 

4.3.13.2. Синусоидальный источник: 
SIN (V1  V2  FC  TD  DF  PHASE), 

SIN (I1 I2  FC  TD  DF  PHASE), 
где SIN – идентификатор синусоидального источника; 

V1(I1) – постоянная составляющая, В (А)  
   (обязательный параметр); 
      V2(I2) – максимальное значение сигнала, В (А)  
   (обязательный параметр); 

   FC – частота сигнала, в герцах (по умолчанию 1/STOP); 
   TD – задержка, в секундах (по умолчанию равна 0); 
   DF – декремент затухания, 1/с (по умолчанию равен 0); 
   PHASE – фаза, в градусах (по умолчанию равна 0). 

Примечание. При наличии затухания величина сигнала синусоидального ис-
точника определяется по формулам 

V(t) = V1+V2*EXP(–(T–TD)*DF)*SIN(2*PI*FC*(T–TD) – PHASE), 
I(t) = I1+I2*EXP(–(T–TD)*DF)*SIN(2*PI*FC*(T–TD) – PHASE). 

 
VIN  100  0  SIN  (0  5  50)  
V1  5  4  SIN (0  25  1КНZ) 

4.3.13.3. Кусочно-линейный источник: 
PWL (T1 V1 T2 V2 ......TN VN), 
PWL (T1  I1  T2  I2 ...… TN IN), 

где  PWL – идентификатор кусочно-линейного источника; 
T1...TN – длительности интервалов; 
V1....VN (I1.... IN) – значения уровней сигнала по окончании соответст-

вующего интервала. 
VIN 1 0 PWL (0 1 2N 1 3N 5 4N 10) 
 

4.3.13.4. Экспоненциальный источник: 
ЕХР (VI V2 TD TER TR TFR), 
ЕХР (I1  I2  TD TER TR TFR), 

где  ЕХР – идентификатор экспоненциального источника; 
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VI (I1) – постоянная составляющая, вольт (ампер); 
V2(I2) – максимальное значение сигнала, вольт (ампер); 
ТD –  время задержки (по умолчанию равно 0); 
TER –  постоянная времени нарастания переднего фронта, в секундах (по 

умолчанию равна TSTEP); 
   TR – постоянная времени начала спада заднего фронта,  в секундах (по умол-
чанию равна TD+TSTЕP); 

   TFR – постоянная  времени   спада,  в  секундах  (по умолчанию равна 
TSTEP). 

VIN 1 0 ЕХР (0 .2  2U 20U 40U 20U)  
I20  1 0 ЕХР (0 .2  2U 20U 40U 20U) . 

4.3.13.5. Амплитудно-модулированный источник: 
SFFM (VI V2 FC MOD FM), 
SFFM (I1  I2  FC MOD FM), 

где     SFFM – идентификатор амплитудно-модулированного источника; 
    V1(I1) – постоянная составляющая, вольт (ампер) (обязательный пара-

метр); 
    V2(I2) – максимальное значение сигнала, вольт (ампер) (обязательный 

параметр); 
    FC – частота сигнала, в герцах (по умолчанию 1/STOP); 
    MOD – коэффициент амплитудной модуляции (по умолчанию равен 0); 
    FM – частота несущей, в герцах (по умолчанию 1/STOP). 
Величина сигнала модулированного источника в момент времени t опреде-

ляется по формулам: 
V(t) = V1+V2*SIN((2*PI*FC*T)+MOD*SIN(2*PI*FM*T), 

  I(t) = I1 + I2*SIN((2*PI*FC*T)+MOD*SIN(2*PI*FM*T). 

VIN 1 0 SFFM (0 2 100MEGH 5 4КН)  
I20  1 0 SFFM (0 2МА 100MEG 5 4КH) 

4.3.14. Управляемые источники напряжения и тока 
Нелинейные зависимые источники могут управляться от нескольких источ-

ников, и их значение определяется с помощью полинома. Полиномом для одно-
го аргумента V1 (одного источника) является 

V = a0 + a1V1 + a2V12  + a3V13 +... . 
Полиномом для двух аргументов V1, V2 (двух управляющих источников) явля-
ется 

V = a0 + a1V1 + a2V2 + a3V12 + a4V1V2 + a5V22 + a6V13 +… . 
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Полиномом для трех аргументов V1,V2,V3 (трех управляющих источников) яв-
ляется 

V = a0 + a1V1 + a2V2 + a3V3 + a4V12 + a5V1V2 + a6V1V3 + a7V22 +… . 

4.3.14.1. Источники тока, управляемые напряжением: 
Gимя N+ N– <Vимя> <NY+> <NY– > [Крутизна] 

или  
Gимя N+ N– POLY(ND) <Vимя> <NY+> <NY– > [Значение коэффициента], 

где G – идентификатор источника тока, управляемого напряжением; 
имя – обозначение элемента на схеме; 
N+, N– соответственно  положительный и отрицательный узлы подключе-

ния источника тока; 
  Vимя – имя управляющего источника напряжения; управляющий источник 
напряжения должен быть независимым и не равным нулю; 

NY+, NY– – положительный и отрицательный узлы подключения управ-
лявшего напряжения; 

Крутизна – крутизна источника; 
POLY – указывает на то, что управляемый источник описывается с помо-

щью полинома; 
ND – число аргументов, входящих в полиномиальную зависимость; 
Значение коэффициента – коэффициенты полинома. 

GBUF 1 2 10 11 1.0 
GNON 100 101 POLY(2) 3 0 2 0 0.0 13.6 .2 005 
 

4.3.14.2. Источники тока, управляемые током: 
Fимя N+ N– <Iимя> <NY+> <NY– > [Значение] 

или  
       Fимя N+ N– POLY(ND) <Iимя> <NY+> <NY–> [Значение коэффициентов], 
где F – идентификатор источника тока, управляемого током; 

имя – обозначение элемента на схеме; 
N+, N– – положительный и отрицательный узлы подключения источника 

тока соответственно; 
Iимя – имя управляющего источника тока; ток, протекающий через управ-

ляющий источник, определяет выходной ток; управляющий источник тока 
должен быть независимым и не равным нулю; 

NY+, NY– – положительный и отрицательный узлы подключения источни-
ка управляющего тока соответственно; 

POLY – указывает на то, что управляемый источник описывается с по-
мощью полинома; 

ND – число аргументов, входящих в полиномиальную зависимость; 
Значение – коэффициент пропорциональности; 
Значение коэффициентов – коэффициенты полинома. 
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FSENS 1 2 VSENS 10.0  
FAMP 13 0 VIN 500  

4.3.14.3. Источники напряжения, управляемые током: 
Нимя N+ N– <Iимя> <NY+> <NY–> [Крутизна]  

или 
Нимя N+ N– POLY(ND) <Iимя> <NY+> <NY–> [Значение коэффициентов], 

где Н – идентификатор источника напряжения, управляемого током; 
имя – обозначение элемента на схеме; 
N+, N– – соответственно положительный и отрицательный узлы подключе-

ния источника тока; 
Iимя – имя управляющего источника тока; ток, протекающий через управ-

ляющий источник, определяет выходной ток; управляющий источник тока 
должен быть независимым и не равным нулю; 

Крутизна – крутизна источника; 
POLY – указывает на то, что управляемый источник описывается с помо-

щью полинома; 
ND – число аргументов, входящих в полиномиальную зависимость; 
Значение коэффициентов – коэффициенты полинома. 

HSENS 1 2 ISENS 10.0  
HAMP 13 0 IN 500 
HNOLIN 100 101 POLY(2) ICNTRL1 ICNTRL2 0.0 13.6 .2 .005 

4.3.14.4. Источники напряжения, управляемые напряжением: 
Еимя N+ N– <Vимя> <NY+> <NY–> [Значение]  

или 
Еимя N+ N– POLY(ND) <Vимя> <NY+> <NY–> [Значение коэффицитентов] , 

где  Е – идентификатор источника напряжения, управляемого напряжением: 
имя – обозначение элемента на схеме; 
N+, N– – соответственно положительный и отрицательный узлы подключе-

ния источника напряжения; 
Vимя – имя управляющего источника напряжения; управляющий источник 

напряжения должен быть независимым и не равным нулю; 
NY+, NY– – соответственно положительный и отрицательный узлы под-

ключения управляющего источника; 
Значение – коэффициент пропорциональности; 
POLY – указывает на то, что управляемый источник описывается с помо-

щью полинома; 
ND – число аргументов, входящих в полиномиальную зависимость; 
Значение коэффициентов – коэффициенты полинома. 
EBUF 1 2 10 11 1.0 
ENON 100 101 POLY(2) 3 0  4 0 1.1  0.0  13.6  2  9.65 0.003 
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Примечания: 
1. Первая форма записи отражает линейную зависимость выходной величины 
от входной. Рассмотрим EBUF: здесь 1 и 2 – выходные узлы; 10 и 11 – управ-
ляющие узлы; 1.0 – крутизна; Vвых=1,0Vвх.  
2. Вторая форма записи отражает нелинейную зависимость выходной величины 
от входной. Рассмотрим ENON: здесь 100 и 101 – выходные узлы; POLY(2) – 
наличие двух управляющих источника; 3 и 0 – узлы подключения первого 
управляющего источника V1; 4 и 0 – узлы подключения второго управляющего 
источника V2; 1.1, 0.0, 13.6, 2, 9.65, 0.003 – коэффициенты полинома; при этом 

Vвых = 1.1 + 0.0V1 + 13.6V2 + 2V1V1 + 9.65V1V2 + 0.003V2V2. 
4.3.15. Подсхемы 
Обращение к подсхеме в программе имеет следующий вид: 

   Х<имя> [узел]  [имя подсхемы], 
при этом должно иметься описание подсхемы в виде 

.SUBCKT  [имя] [Узел] 
 ……………………………….. 

.ENDS  
где SUBCKT – запись, описывающая подсхему; 

узел – узлы подключения подсхемы; 
Х – идентификатор подсхемы; 
Узел – узлы подключения подсхемы (для вложенной); 
.ENDS – оператор конца описания подсхемы. 
При вызове подсхемы запись [X . . . ] замещается описанием подсхемы. При 

вызове подсхемы номера узлов, указанные в вызывающей записи, замещают 
номера узлов, заданные при описании подсхемы. Уровень вложенности может 
быть любой, но нельзя допускать зацикливания, т. е. если подсхема А вызывает 
подсхему В, то из подсхемы В нельзя снова вызывать подсхему А.  

.SUBCKT OPAMP 1 2 101 102 
X1 1 2 4 UNITAMP 
.ENDS 
.SUBCKT UNITAMP 1 2 5  
R1 4 6 10К 
 ........... 
. ENDS 

4.4. Директивы управления 
Записи с директивами управления позволяют задавать требуемый вид ана-

лиза, его параметры, форму представления выходной информации и ряд вели-
чин, определяющих ход вычислительного процесса. Рассмотрим директивы 
управления более подробно. 

 
 

Би
бл
ио
те
ка

 БГ
УИ
Р



  52

4.4.1. Директива [.TEMP]: 
.TEMP t1 <t2<t3...>> 

Директива [.TEMP] задает различные температуры t1,t2,t3,..., в градусах по 
Цельсию, для каждой из которых производится моделирование схемы. Величи-
на t1, меньшая –223 градусов, игнорируется. Параметры моделей задаются при 
номинальной температуре, которая может быть изменена заданием директивы 
[.OPTIONS] с опцией TNOM. Если директива [.TEMP] отсутствует, то модели-
рование проводится при температуре, равной номинальной. 

.TEMP  –27  0  27 

.TEMP  –55.0   25   155.5 
4.4.2. Директива [.NODESET]  

.NODESET  V(Номер узла) = [Напряжение] <...> 
Данная директива позволяет задать начальные напряжения перечисленных 

в ней узлов для анализа по постоянному току и расчета переходных процессов. 
Она должна применяться при моделировании схем с двумя и более устойчивы-
ми состояниями для улучшения сходимости расчета по постоянному току и вы-
бора правильной рабочей точки. Применение директивы [.NODESET] при рас-
чете схем с одним устойчивым состоянием позволяет в ряде случаев снизить 
затраты машинного времени на моделирование и не влияет на окончательную 
рабочую точку. 

.NODESET  V(22) = 2.1  V(100) = 0   V(5) = –12 

.NODESET  V(11) = –5.5V   V(100) = 100  V(5) = –1V 
4.4.3. Директива [.IС]:  

.IС V(Номер узла)=[Напряжения] <...> 
Директива [.IС] задает начальные условия при расчете переходных процес-

сов для перечисленных в ней узлов. В зависимости от опции [UIС] в директиве 
[.TRAH] директива [.IС] может иметь различное действие: 

 а) при задании опции [UIC] в директиве [.TRAN] значения узловых напря-
жений, определенных в директиве [.IС], используются при расчете начальных 
условий в моделях емкости, диода, транзисторов, что эквивалентно заданию 
опции [IС=...] в каждом описании модели полупроводникового прибора, но в 
более удобной форме. При одновременном задании директивы [.IС] и опции 
[IС=...] принимается значение, указанное в опции. В директиве [.IС] должны 
быть обязательно заданы напряжения на всех источниках постоянного тока, оп-
ределяющих начальные условия для полупроводниковых приборов; 

б) если опция [UIC] в директиве [.TRAN] не задана, то перед моделирова-
нием определяется рабочая точка  схемы по постоянному току, т. е. директива 
[.1С] не оказывает влияния на результат моделирования.  

.IС  V(22) = 2.1  V(102) = 0   V(3) = –12 

.IС  V(11) = –22.3 V(102) = 100  V(3)= –1V 
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4.4.4. Директива [.OP]:  
.OP 

При задании директивы [.OP] программа проводит анализ схемы по посто-
янному току. При этом индуктивности представляются в виде короткого замы-
кания, емкости закорачиваются. Данный вид анализа позволяет рассчитать токи 
активных элементов, рассеиваемые мощности всех источников напряжения. 
Определяются также линеаризованные параметры всех нелинейных управляе-
мых источников и полупроводниковых элементов. При отсутствии этой дирек-
тивы рабочие точки все равно рассчитываются, но в выходной файл выводится 
лишь список узловых напряжений. 

Пример:  .OP 
 

4.4.5. Директива [.DC]: 
.DC [Имя источника]  VB1  VE1  VS1 <[Имя источника]  VB2 VE2 VS2> 
Директива [.DC] определяет источник напряжения или тока, для которого 

рассчитываются характеристики схемы по постоянному току, а также задает 
пределы изменения и шаг при построении передаточных характеристик схемы. 
В программе предусмотрен расчет передаточных характеристик при одновре-
менном изменении параметров двух источников. В этом случае сначала будет 
изменяться значение параметра первого источника при каждом значении пара-
метра второго источника, что используется при расчете вольт-амперных и вы-
ходных характеристик полупроводниковых приборов. 

Опции директивы [.DC] означают: 
VB1,VB2 – начальные напряжения или токи источников; 
VE1,VE2 – конечные напряжения или токи источников; 
VS1,VS2 – соответствующие приращения. 
.DC  VIN  0.25  2.2  0.1 
.DC  VDS  0 10  0.5  VGS   0 5  1 
.DC  VCE  0 10  0.25  IB  0  10u  lu 

4.4.6. Директива [.TF]:  
.TF [Выходная величина] [Входной источник] 

Директива позволяет рассчитать на постоянном токе в режиме малого сиг-
нала в зависимости от типов входного источника и выходной величины сле-
дующие характеристики: 

1) передаточную характеристику по току или напряжению; 
2) входное сопротивление; 
3) выходное сопротивление. 
.TF  V(10.2)  VIN  
.TF  I(VS)  VIN 

4.4.7. Директива [.TRAN]:  
.TRAN</OP>  TS  ТЕ  <ТВ  <ТМАХ>  <UIC> 

Директива [.TRAN] позволяет проводить расчет переходных процессов,  
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при этом: 
 TS – величина шага при выводе таблиц и графиков; 
 ТЕ – время окончания расчета переходных процессов; 
 ТВ – начало переходного процесса (по умолчанию ТВ=0). В интервале 

времени [0,ТВ] расчет переходных процессов все равно производится для опре-
деления начальных условий, однако результаты расчета не запоминаются. 

ТМАХ – максимальный шаг интегрирования. По умолчанию ТМАХ равен 
наименьшему из двух величин: TS либо (ТЕ–ТВ)/50.  

Опция [/ОР] используется для вывода значений рабочей точки схемы.  
Опция [UIC] позволяет использовать в качестве начальных условий значе-

ния параметров [IC=...], заданных при описании элементов схемы. 
.TRAN  1ns  100ns 
 .TRAN/OP  1ns 1000ns l00n 
 .TRAN  1  100  UIC 

4.4.8. Директива [.AC]: 
.AC  DEC  ND FB FE 
.AC  LIN  NP  FB FE 
.AC  OCT NO FB FE 

Директива определяет расчет электронной схемы по переменному току и 
позволяет выполнить анализ ее характеристик в заданном диапазоне частот. В 
схеме обязательно должен быть один независимый источник с параметром 
[АС].  

Опции в директиве [.АC] означают: 
DEC – изменение частоты по декадам; 
ND – число точек в декаде; 
LIN – линейное изменение частоты; 
NP – число точек в диапазоне; 
ОСТ – изменение частоты по октавам; 
NO – число точек в октаве; 
FB – начальная частота анализа; 
FE – конечная частота анализа. 
.AC  DEC  10  1  10000  
.AC ОСТ 10 10 100К  
.AC LIN 100 1K 10MEG 

4.4.9. Директива [.FOUR]:  
.FOUR [Частота основной гармоники] [Выходные переменные] 

Директива предназначена для проведения Фурье-анализа и соответственно 
определения гармонических составляющих выходного сигнала. При этом вы-
числяются амплитуды и фазы гармонических составляющих, а также их вели-
чины, отнесенные к амплитуде и фазе первой гармоники. 

Директива [.FOUR] работает только совместно с директивой [.TRAN], чис-
ло рассчитываемых гармоник равно 9. 
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.FOUR 10K  V(12) V(13)  I(IVIN) 

.FOUR 50HZ  V(5) V(7) 
4.4.10. Директива [.SENS]:  

.SENS [Выходная переменная] <[Выходная переменная]> 
При наличии директивы [.SENS] производится анализ чувствительности на 

постоянном токе для всех перечисленных выходных переменных по отноше-
нию к каждому из параметров схемы. 

.SENS  V(15)  V(16.2)  V(22)  

.SENS  V(2)   I(VCC) 
4.4.11. Директива [.NOISE]:  

.NOISE  [Выходная переменная]  [Входной источник] 
Директива [.NOISE] предназначена для расчета шумовых характеристик и 

используется совместно с директивой [.AC]. Программа рассчитывает шумы 
для заданной выходной переменной, эквивалентные шумы, приведенные ко 
входному источнику, выводит таблицу весовых коэффициентов для каждого 
источника шумов в рамках частотного диапазона, определяемого параметром 
NSUM. Если NSUM=0, то таблица не выводится. 

4.4.12. Директива [.PLOT]: 
.PLOT [DC]  [AC]  [NOISE] [TRAN]  [ВыхПер] [НП]  [ВП] 

Директива предназначена для представления результатов расчета в виде 
таблиц и графиков, формируемых с помощью текстовых символов в файле 
*.out.  

Опции директивы: 
[DC], [AC], [NOISE], [TRAN] – вид анализа, для которого выводится вы-

ходная информация; 
[ВыхПер] – выходные переменные, для которых строится таблица и графи-

ки; 
[НП] – нижний предел; 
[ВП] – верхний предел. 
При построении графика в программе автоматически определяются макси-

мальная и минимальная величины выходных переменных и происходит мас-
штабирование осей координат так, чтобы график подходил под эти размеры. 
Однако масштабированием можно управлять, если указать пределы осей коор-
динат. На один график одновременно можно вывести до 8 переменных. 

.PLOT  DC  V(3)  V(2.3)  V(R1)  I(VIN)  I(R2)  IB(Q3) VBE(Q3)  

.PLOT  AC  VM(2)  VP(2)  VM(3,4)  VG(5) VDB(5)  IR(6)  II(6)  

.PLOT  NOISE   INOISE   ONOISE   DB(INOISE) DB(ONOISE) 

.PLOT  TRAN  V(3)  V(2,3)  (0,5V)  ID(M2)   I(VCC) (-50MA,50MA) 
4.4.13. Директива [.PROBE]: 

.PROBE [Выходные переменные] 
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 Директива предназначена для передачи данных в графический постпроцес-
сор Probe и запуска последнего на исполнение. В результате выполнения ди-
рективы появляется возможность просмотра результатов моделирования в гра-
фическом виде. Если выходные переменные не указаны, то в дальнейшем в ок-
не (см. рис. 3.13) возможно отобразить все токи, напряжения, мощности для 
данной схемы. В противном случае возможен только выбор из указанных вы-
ходных переменных.  

.PROBE 

.PROBE V(1) I(R) 
4.4.14. Директива [.LIB]: 

.LIB [Имя библиотеки] 
 Директива служит для подключения библиотеки моделей компонентов. 

.LIB NOM.LIB 

.LIB C:\PSPICE\MYLIB.LIB 
 

5. СОЗДАНИЕ ПОЛЬЗОВАТЕЛЬСКИХ БИБЛИОТЕК 
 Для полноценной работы в среде Orcad необходимо наличие библиотек, со-
держащих используемые разработчиком элементы. Многие библиотеки с опи-
саниями зарубежных элементов, разработанные фирмами-производителями, 
можно найти с помощью Internet. К сожалению, отечественные производители 
не обеспечивают поддержку своих изделий в системах автоматизированного 
проектирования, поэтому при проектировании приходится либо использовать 
зарубежные аналоги, либо создавать свои библиотечные элементы.  
 Для создания библиотечного элемента, пригодного для моделирования с 
помощью программы Capture, необходимо: 
 1. Создать модель, описывающую функционирование элемента, в соответ-
ствии с соглашениями программы PSpice. 
 2. Создать условное графическое обозначение (УГО) элемента. 
 3. Связать УГО и модель в единый библиотечный элемент. 
 При дальнейшей разработке печатной платы необходимо также разработать 
чертеж посадочного места элемента и внедрить его в библиотечный элемент. 

5.1. Создание моделей элементов 
 В зависимости от вида описываемого устройства все множество моделей 
можно разделить на два вида: 
 1. Модели, имеющие встроенное описание на языке PSpice. При создании 
пользовательской модели необходимо задать необходимые параметры. 

Пример: 
.MODEL D_MY D VJ = 0.75 

 2. Модели, описываемые с помощью подсхем, содержащих описание элек-
трической схемы устройства, а также набор параметров, значения которых за-
даются при использовании модели либо принимаются равными значениям по 
умолчанию. 
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Пример: 
.SUBCKT MY_CIR IN OUT AGND 

  + PARAMS: C1VAL=1 C2VAL=1 R1VAL=1 R2VAL=1 GAIN=10000 
  C1 IN N1 {C1VAL} 
  C2 N1 OUT {C2VAL} 
  R1 IN N1 {R1VAL} 
  R2 N1 OUT {R2VAL} 
  EAMP1 OUT AGND VALUE={V(AGND,N1)*GAIN} 

      .ENDS 
 Файлы с описаниями моделей имеют расширения *.mod (содержит только 
одну модель) или *.lib (содержит как одну, так и целую библиотеку моделей) и 
представляют собой текстовые файлы, которые в принципе могут создаваться в 
любом текстовом редакторе. 
 При создании моделей первого вида удобно пользоваться программой 
PSpice Model Editor, входящей в состав пакета Orcad, которая по паспортным 
данным рассчитывает параметры моделей полупроводниковых приборов (дио-
дов, биполярных, полевых, статически индуцированных биполярных транзи-
сторов, мощных МОП-транзисторов, транзисторов Дарлингтона, макромоделей 
операционных усилителей, компараторов напряжения, регуляторов напряже-
ния, стабилизаторов напряжения и моделей магнитных сердечников). Отметим, 
что Orcad 9.2 Lite Edition позволяет рассчитать только модели диодов. 
 В качестве примера работы с программой PSpice Model Editor рассчитаем 
параметры модели полупроводникового диода. Сначала по команде FileOpen 
указывается имя файла библиотеки моделей диодов (если такого файла не 
существует, то создается новый файл с расширением .lib по команде 
FileNew). Далее по команде ModelNew вводится имя модели диода и в 
предлагаемом списке типов моделей указывается его тип Diode (рис. 5.1). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Рис. 5.1. Окно выбора типа модели 
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После ввода имени и типа модели на экран выводится список параметров 
модели (рис. 5.2). В левой части экрана приведен перечень моделей в данной 
библиотеке, в правой – перечень вводимых паспортных данных параметров 
математической модели и их графическое отображение, в нижней части окна 
выводится перечень параметров математической модели, рассчитанной на 
основе введенных паспортных данных. Первоначально всем параметрам 
модели присваиваются значения по умолчанию. Паспортные данные вводятся 
порциями, соответствующими различным режимам работы компонента.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 5.2. Окно редактирования модели 
 

Вводимые данные при нажатии соответствующей кнопки (ввод команды 
Extract) немедленно отображаются графически. На основании порции 
введенных данных по команде Extract рассчитывается ряд параметров 
математической модели, значения которых отображаются  в окне Parameters 
(см. рис. 5.2). Редактирование значений отдельных рассчитанных параметров 
математической модели выполняется после щелчка в соответствующем окне. 
По команде PlotAdd Trace возможно построить семейство характеристик при 
вариации температуры или других параметров модели. По умолчанию 
предлагается построить графики характеристик при изменении температуры. 
Имя варьируемой переменной изменяется по команде PlotAxis Settings. 
Например, для диодов возможна вариация параметров IS, N, RS, IKF, EG и XTI. 

Построение модели завершается командой записи обновленных данных в 
библиотечный файл FileSave. 
 PSpice Model Editor позволяет также редактировать и создавать модели вто-
рого вида (в виде подсхем), однако редактирование происходит в текстовом ви-
де и не имеет преимуществ перед обычным текстовым редактором. 
 Для создания сложных моделей второго вида можно рекомендовать исполь-
зование программы Capture. При этом сначала создается принципиальная схе-
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ма, на которой помещаются иерархические порты, указывающие вход и выход 
(например, приведенная на рис. 5.3, а). После этого необходимо создать файл, 
содержащий описание подсхемы. Для этого необходимо активизировать окно 
менеджера проекта, после чего из появившегося пункта меню Tools выбрать 
подпункт Create Netlist. В появившемся окне перейдем на вкладку PSpice и вы-
берем в разделе Options пункт Create SubCircuit Format Netlist (рис. 5.3, б). По-
сле выбора места сохранения и имени файла нажмем кнопку OK – и наша мо-
дель готова. 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 5.3. Этапы создания модели второго вида 
 

5.2. Создание законченного пользовательского элемента 
 Рассмотрим создание законченного библиотечного элемента на примере 
разработки ключа, замыкаемого в определенный момент времени.  
 1. Разработаем модель ключа, для чего создадим текстовый файл, описы-
вающий наше устройство с использованием источника трапецеидальных им-
пульсов и ключа, управляемого напряжением: 
 .SUBCKT  Switch  1  2  PARAMS: 

+ tClose=0; момент замыкания ключа 
+ ttran=1u; время срабатывания ключа 
+ Rclosed=0.01; сопротивление в закрытом состоянии 
+ Ropen=1Meg ; сопротивление в открытом состоянии 
V1 3 0 pulse(0 1 {tClose} {ttran} 1 10k 11k) 
S1 1 2 3 0 Smod 
.model Smod Vswitch(Ron={Rclosed} Roff={Ropen}) 
.ends 

 Сохраним полученный файл под именем Switch.lib. 
 2. Запустим программу PSpice Model Editor. В меню File выберем пункт 
Create Capture Parts. В появившемся окне (рис. 5.4) в строке Enter Input Model 
Library укажем файл, содержащий созданную модель (C:\Switch\Switch.LIB), 
при этом в строке Enter Output Part Library появится предлагаемое название 
файла с описанием создаваемого элемента (C:\Switch\Switch.olb), с чем мы со-
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гласимся, нажав кнопку ОК. После этого будет создан файл библиотеки 
Switch.olb. Отметим, что аналогичный ре-
зультат можно получить с помощью про-
граммы Capture, для чего необходимо в 
меню Tools выбрать пункт Generate Part. 
При этом также происходит обращение к 
программе PSpice Model Editor, однако 
без появления оконного интерфейса по-
следней. Генерация элементов по умолча-
нию происходит на основе библиотеки 
C:\ProgramFiles\OrcadLite\Capture\Library\ 
PSpice\modeled.etc. При необходимости 

изменения этой установки нужно в меню 
программы PSpice Model Editor выбрать 

пункт ToolsOptions и изменить пункт Base Part On. 
 3. В программе Capture откроем библиотеку Switch.olb (FileOpen Li-
brarySwitch.olb). В появившемся окне менеджера проекта дважды щелкнем на 
названии элемента Switch, после чего появится окно с изображением символа 
элемента, представленное на рис. 5.5, а. Пунктирная линия очерчивает границы 
элемента, которые легко изменяются с помощью мыши. При использовании 
элемента в схеме граница не изображается. С помощью панели инструментов, 
расположенной справа в главном окне, нарисуем условное графическое обозна-
чение ключа. В результате получим УГО, представленное на рис. 5.5, б. 
 
 
 
 
 
 
 
 
                                                                                                 

Рис. 5.5. Окно с изображением УГО элемента 

 Дважды щелкнем левой кнопкой 
мыши на белом поле окна 
(см. рис. 5.5, б). В результате появится 
окно User Properties (рис. 5.6). Сделаем 
невидимыми номера узлов, для чего 
щелкнем на строчке Pin Number Visible, 
после чего в нижней части окна (см. 
рис. 5.5) изменим значение с True на 
False. Сделаем видимым параметр 
TCLOSE, для чего дважды щелкнем ле-
вой кнопкой мыши на строчке 
TCLOSE, после чего в появившемся 

 

Рис. 5.4. Окно создания элемента 
 в программе PSpice Model Editor 

Рис. 5.6. Окно User Properties 
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окне Display Properties (рис. 5.7) в группе Display Format активизируем пере-
ключатель Name and Value.  

При необходимости таким же образом можно сделать видимыми сопротив-
ления ключа в открытом и закрытом состояниях и другие параметры. 
Закроем окно User Properties, нажав кнопку ОК.  

Графическое изображение получившегося элемента приведено на рис. 5.8.  
 
 
 
 
 
 
 
 
 
 
 
 
 

Сохраним библиотеку, выбрав пункт Save меню File. Создание пользова-
тельского библиотечного элемента закончено.  
 Проверим функционирование нашего элемента, для чего создадим новый 
проект и соберем схему, представленную на рис. 5.9. На рис. 5.10 а, б приведе-
ны  графики выходного напряжения при значениях параметра TCLOSE, равных 
0 и 5 с соответственно. 

 
 
 
 
 
 
 
 
 
 
 

 

 
Из рис. 5.10 мы видим, что создан-

ный библиотечный элемент функционирует правильно, т. е. замыкание ключа 
происходит в заданный момент времени. Небольшое прохождение входного 
сигнала на выход при разомкнутом контакте обусловлено наличием сопротив-
ления Ropen, которое мы приняли равным 1МОм. Увеличение Ropen прибли-
жает созданный элемент к идеальному. 

 

Рис. 5.7. Окно Display Properties 

Рис. 5.9. Схема для проверки  
функционирования элемента 

  Рис. 5.10. Графики выходного напряжения 

а 

б 

           Time

0s 2s 4s 6s 8s 10s
V(R1:2)

-10V

0V

10V            Time
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-10V

0V

10V

 

Рис. 5.8. Графическое изображение 
элемента 
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Единственным недостатком созданного элемента является то, что он имеет 
позиционное обозначение U, что не соответствует принятому стандартному 
обозначению ключевого элемента S. Для исправления этого недостатка вновь 
откроем библиотеку с нашим элементом, для чего в программе Capture в меню 
выберем пункты FileOpenLibrarySwitch.olb. Затем выберем пункты меню 
OptionsPackage Properties. В появившемся окне Edit Part Properties в поле Part 
Reference Prefix заменим U на S. 

Если при использовании пользовательского элемента в схеме программа 
Capture не может найти созданную библиотеку с моделью элемента и выдает 
соответствующее сообщение об ошибке (например ERROR – Subcircuit Switch 
used by X_S1 is undefined), то необходимо открыть окно редактирования про-
филя моделирования (см. рис. 3.12), перейти на закладку Libraries, указать в 
строке Filename имя и путь к библиотеке, после чего либо сделать созданную 
библиотеку глобальной (доступной всем проектам), нажав кнопку Add As Glob-
al, либо добавить ее только к созданному проекту, нажав кнопку Add to Design 
(рис. 5.11). 

 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 5.11. Объявление созданной библиотеки в качестве глобальной 
 
 Рассмотрим второй путь создания библиотечного элемента, при котором 
файл *.olb не генерируется в автоматическом режиме, а создается вручную. 

1. Разработаем модель ключа так же, как это было сделано выше.  
2. Запустим программу Capture и создадим новую библиотеку (FileNew 

Library). Присвоим новой библиотеке имя Switch2.olb, для чего сохраним ее под 
этим именем командой Save As. Создадим новый элемент, для чего выделим в 
менеджере проекта заголовок библиотеки одним щелчком левой кнопки мыши, 
затем щелкнем правой кнопкой и выберем пункт New Part (рис. 5.12). В резуль-
тате появится окно New Part Properties (рис. 5.13). 

В графе Name данного окна укажем имя элемента (Switch). В графе Part 
Reference Prefix необходимо указать обозначение элемента на схеме (например, 
для резистора – R, для конденсатора – С и т. д.). Для ключа выберем стандарт-
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ное обозначение S. В графе PCB Footprint указывается посадочное место, кото-
рое будет использоваться при разработке печатной платы. Так как в дальней-
шем не предполагается использовать наш элемент для разработки печатной 
платы, то оставим эту графу пустой. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Переключатель Create Convert View предназначен для создания альтерна-
тивного изображения элемента (если существуют несколько вариантов приня-
тых обозначений).  

Раздел Multiple-Part Package предназначен для указания количества эле-
ментов в одном корпусе, при этом элементы могут быть как однотипными 
(Homogeneous), например, все элементы – инверторы, так и разнотипными (He-
terogeneous), например, кроме инверторов в корпус входят также элементы 
ИЛИ.  

Раздел Part Numbering позволяет указать способ нумерации элементов: Al-
phabetic – буквенный, Numeric – числовой.  
 Кнопка Part Aliases позволяет присвоить элементу один или несколько 
псевдонимов, что позволяет уменьшить размер библиотеки за счет использова-
ния одного библиотечного элемента для описания различных приборов с оди-

наковым функциональным назначением 
(например: К164ЛА7, К561ЛА7, 
К1564ЛА7). 
 Кнопка Attach Implementation позво-
ляет добавить описание, в том числе мо-
дель для программы PSpice (рис. 5.14). В 
графе Implementation укажем имя модели 
Switch.  

После добавления модели закроем ок-
но (см. рис. 5.13), нажав кнопку ОК. 

Рис. 5.12. Создание нового элемента Рис. 5.13. Окно New Part Properties 

Рис. 5.14. Создание связи 
с PSpice моделью 

Би
бл
ио
те
ка

 БГ
УИ
Р



  64

В результате получим окно редактирования элемента (рис. 5.15).  
 Добавим выводы элемента, нажав кнопку Вывод (Place Pin) (см. табл. 3.3) 
панели инструментов. При этом появится окно, показанное на рис. 5.16.  
 
 
 
 
 
 
 
 
 
 
 
 
 

Рассмотрим назначение полей: 
Name – имя узла. Может быть как цифровое, так и буквенное. При необхо-

димости ввода имени с чертой вверху нужно после каждой буквы поставить 
слэш (например R\E\S\E\T\). 

Number – номер узла (можно не указывать). 
Width – тип вывода. Если вывод соединен с одиночным проводником, не-

обходимо выбрать Scalar при соединении вывода с шиной – Bus. 
Shape – вид графического изображения вывода: 
            – Line; 

            – Dot; 
– Clock; 

        – Dot-Clock; 
 – Zero; 
 – Short; 

Type – тип вывода по функциональному назначению: 
  3-state – вывод с тремя состояниями (низкий уровень, высокий уровень, 
высокоомное состояние); 
  Bidirectional – двунаправленный вывод (вход – выход); 
  Input – вход; 
  Output – выход; 

Open collector – открытый коллектор; 
  Open emitter – открытый эмиттер; 
  Passive – пассивный вывод. Пассивный вывод обычно используется в 
устройствах,  не содержащих источников энергии (например, такие выводы 
имеет резистор). 
 Power – вывод питания или «земли». 

Переключатель Pin Visible позволяет отобразить или убрать изображение 
выводов питания. 

Рис. 5.16. Окно создания вывода 
элемента 

Рис. 5.15. Окно редактирования 
элемента 
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Кнопка User Properties отображает соответствующее окно, позволяющее 
указать дополнительные свойства вывода, а также произвести редактирование 
существующих. 
 Добавим два пассивных вывода в форме линии (Line) с именами 1 и 2. По-
сле этого нарисуем графическое изображение ключа так же, как это было сде-
лано выше.  
 В отличие от первого варианта создания библиотечного элемента шаблон 
PSpiceTemplate, необходимый для моделирования с помощью программы 
PSpice, автоматически не создается. Поэтому  добавим его вручную, для чего, 
дважды щелкнув левой кнопкой мыши на белом фоне, перейдем в окно User 
Properties (см. рис. 5.6). Нажмем кнопку New, в поле Name введем имя PSpice-
Template, в поле Value введем значение (структура приведенного описания бу-
дет пояснена ниже): 
 X^@REFDES %1 %2 @MODEL PARAMS:  ?TCLOSE|TCLOSE=@ TCLOSE|| 
TCLOSE=0|?TTRAN|TTRAN=@TTRAN||TTRAN=1U|?RCLOSED|RCLOSED=@
RCLOSED||RCLOSED=0.01|?ROPEN|ROPEN=@ROPEN||ROPEN=1MEG|, 
затем нажмем кнопку ОК. 

Аналогично создадим параметры TCLOSE, 
TTRAN, RCLOSED, ROPEN, сделав параметр 
TCLOSE видимым. 
 Окончательный вид получившегося элемента 
приведен на рис. 5.17.  

Для проверки правильности функционирования 
созданного элемента включим его в схему 
(см. рис. 4.9). После моделирования получим те же 
графики, что и ранее (см. рис. 5.10), что подтверждает 
работоспособность нового элемента. 
 Наиболее сложным этапом при втором способе 

создания элемента является написание шаблона PSpiceTemplate. Рассмотрим 
структуру этого шаблона более подробно. 

Шаблон состоит из списка атрибутов. Атрибуты, состоящие из стандартных 
символов, копируются в список соединений без изменений. Стандартные сим-
волы состоят из алфавитно-цифровых символов, знаков «$»,«_», пробелов и 
знаков пунктуации. Если перед именем атрибута помещен специальный знак 
«@», «?», «~», «#» или «&», то в зависимости от его вида атрибуты шаблонов 
заменяются следующими величинами: 

@<имя> – значением атрибута <имя>. В отсутствие указанного атрибута 
или его значения выдается сообщение об ошибке; 

&<имя> – значением атрибута <имя>, если этот атрибут определен; 
?<имя>s...s – заменяется текстом, помещенным между одинаковыми сим-

волами s, если атрибут определен; 
~<имя>s...s – заменяется текстом, помещенным между одинаковыми сим-

волами s, если атрибут не определен; 

Рис. 5.17. Окончательный 
вид элемента 
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#<имя>s...s – производятся те же действия, что и при наличии знака «?», но 
остальная часть шаблона удаляется, если <имя> не определено. 

Символы s, ограничивающие текст, могут быть любыми неалфавитными 
символами (сами они в список соединений не переносятся); наиболее часто ис-
пользуются следующие: « . », « , », « / », « | ». 

 Внутри этого текста допускается вложение, т. е. размещение атрибутов, 
предваряемых специальными знаками. 

Знак «ˆ» также специальный. Он заменяется указанием полного пути досту-
па к компонентам, имеющим иерархическую структуру. Для компонентов, на-
ходящихся на высшем уровне иерархии, в списке соединений этот знак заменя-
ется знаком подчеркивания «_». 

Последовательность знаков «\n» приводит к переходу на следующую строку 
в списке соединений. Так что шаблон PSpiceTemplate, который размещается на 
одной строке практически неограниченной длины, в списке соединений может 
быть размещен на нескольких строках. Кроме того, таким способом в шаблоне 
PSpiceTemplate можно описать подключение к основному компоненту ряда до-
полнительных (например, учесть сопротивление потерь катушки индуктивно-
сти и т. п.). 

Имена выводов в шаблоне предваряются знаком «%». Имена выводов сим-
волов перечисляются в шаблоне в том порядке, в котором они должны быть за-
писаны для каждого компонента по правилам PSpice. В списке соединений они 
замещаются именами цепей, к которым они подсоединены на схеме. В шаблоне 
под именем вывода понимаются все символы, расположенные между символом 
«%» и первым разделителем (пробелом или запятой). 

В шаблоне PSpiceTemplate имена компонентов в списке соединений долж-
ны начинаться с префикса, обозначающего их тип (R – резистор, Q – биполяр-
ный транзистор, Х – подсхема и т.п.).  
 В качестве примера рассмотрим шаблон резистора, имеющего два узла 
(1 и 2) и два требуемых свойства: REFDES и VALUE.  

Запишем шаблон PSpiceTemplate:  
R^@REFDES %1 %2 @VALUE. 

При использовании такого резистора в схеме список соединений (Netlist) может 
иметь вид R_R15 23 0 10К; при этом REFDES равно R15, VALUE равно 10К, 
резистор включен между 23 и 0 узлами. 
 Рассмотрим шаблон подсхемы Z, имеющей два узла (a и b) и изменяемый 
параметр подсхемы G, по умолчанию равный 1000:  

X^@REFDES %a %b Z PARAMS: ?G|G=@G|~G|G=1000|. 
 Данный шаблон может быть записан и в форме (если …, то) 

X^@REFDES %a %b Z PARAMS: ?G|G=@G||G=1000|. 
 При использовании подсхемы в схеме список соединений может иметь  вид 
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при указании значения G, равного 150, 
X_U3 25 11 Z PARAMS: G=150; 

 при отсутствии указания значения G 
X_U3 25 11 Z PARAMS: G=1000. 

 
 

5.3. Создание пользовательских символов 
 К символам в программе Orcad относятся: символы «земли» и питания 
(Power), межстраничные соединители (Off-Page Connector), иерархические пор-
ты (Hierarchical Port) и основные надписи (Title Block). Набор символов, по-
ставляемых с программой Orcad, находится в библиотеке по адресу C:\Program 
Files\OrcadLite\Capture\Library\capsym.olb. К сожалению, не все из них соответ-
ствуют требованиям отечественных стандартов, поэтому возникает необходи-
мость редактирования существующих и создания оригинальных пользователь-
ских символов. 
 Наиболее актуальной задачей является создание основных надписей, по-
этому рассмотрим данный процесс более подробно.  
 Создадим новую библиотеку, для чего в программе Capture выполним 

пункты меню FileNewLibrary. В поя-
вившемся окне менеджера проекта щелк-
нем правой кнопкой мыши на названии 
библиотеки и выберем пункт New Symbol 
(см. рис. 5.12). В появившемся окне New 
Symbol Properties (рис. 5.18) введем имя 
нашего символа (My Title) и выберем его 
тип (Title Block). После нажатия кнопки ОК 
перейдем в окно редактирования символа, 
аналогичное окну редактирования элемента 
(см. рис. 5.15). 

С помощью инструментов редактора 
символов (рис. 5.19, пояснения приведены 
в табл. 3.2) нарисуем требуемую основную 
надпись, а все подписи выполним с помо-
щью инструмента «Текст». 
 Получившаяся основная надпись при-
ведена на рис. 5.20. 
 Наша основная надпись пока не содер-

жит сведений, относящихся к разработчикам, т. е. не заполнены поля «Разраб.», 
«Пров.» и т. д. Заполнение этих полей с помощью инструмента «Текст» приве-
дет к созданию символа с ограниченными возможностями использования, что 
противоречит концепции создания библиотечных элементов. 

В то же время Orcad обладает возможностями автоматического заполнения 

Рис. 5.18. Окно New Symbol Properties 

Рис. 5.19. Инструменты редактора 
символов Би
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полей основной надписи при создании нового проекта, при этом автозаполне-
ние производится в соответствии с установками шаблона Design Template, для 
изменения которого необходимо выполнить пункты меню OptionsDesign 
Template. 
 
 
 
 
 
 
 
  
 

Рис. 5.20. Основная надпись 

 Отложим на некоторое время процесс создания основной надписи и рас-
смотрим возможности автозаполнения. Выполним пункты меню Op-

tionsDesign Template, после чего перейдем 
на вкладку Title Block. Появится окно, при-
веденное на рис. 5.21. Девять полей, объе-
диненных в группу Text, доступны для вво-
да данных, используемых при автозаполне-
нии. Для реализации данной возможности 
необходимо вставить в основную надпись 
ссылки на эти поля.  

Закроем окно рис. 5.21 и вернемся к ре-
дактированию символа. 
 Щелкнем два раза левой кнопкой мыши 
в окне редактора символом (либо выполним 

пункты меню OptionsPart Properties), в результате чего перейдем в окно ре-
дактирования свойств символа (рис. 5.22). Создадим новый параметр, для чего 
нажмем кнопку New. В появившемся окне (рис. 5.23) в графе Name введем на-
звание параметра в соответствии с табл. 5.1, графу Value оставим пустой. 
 
 
 
 
 
 
 
 
 
 

Рис. 5.21. Окно Design Template 

Рис. 5.22. Окно редактирования 
            свойств символа 

 

Рис. 5.23. Окно создания нового 
параметра 
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Таблица 5.1 
Ссылки на поля шаблона Design Template 

Название поля в шаблоне 
Design Template  Название параметра 

Title Title 
Organization Name OrgName 

Organization Address 1 OrgAddr1 
Organization Address 2 OrgAddr2 
Organization Address 3 OrgAddr3 
Organization Address 4 OrgAddr4 

Document Number Doc 
Revision RevCode 

Cage Code Cage Code 
 

Закроем окно создания нового параметра, в окне редактирования свойств 
символа нажмем кнопку Display, затем установим видимость Value Only. Для 
того чтобы надпись можно было заполнить на русском языке, в разделе Font 
нажмем кнопку Change, затем в поле Набор символов выберем пункт Кирилли-
ца. Аналогично создадим другие параметры. Для того чтобы вставить дату, не-
обходимо в качестве названия параметра выбрать Design Create Date. 

Часть основной надписи с созданными автозаполняемыми полями приведе-
на на рис. 5.24, при этом для ввода фамилий 
разработчика, контролера и проверяющего 
использованы поля Organization Address (ад-
рес организации), т. к. адрес организации со-
гласно ГОСТу в основную надпись не вхо-
дит. Сохраним созданную библиотеку, вы-
полнив пункты меню FileSave As (при 
этом, для того чтобы сохранилась именно 
библиотека с расширением файла *.olb, не-
обходимо, чтобы в окне менеджера проекта 

было выделено название библиотеки (см. рис. 5.12)).  
 Проверим функционирование нашего элемента. Для этого произведем ре-
дактирование шаблона Design Template, заполнив необходимые поля в группе 
Text в соответствии с выбранными связями с полями основной надписи. Также 
необходимо заполнить поля в группе Symbol, указав в графе Library Name на-
звание созданной библиотеки с полным путем к ней (например C:\Program 
Files\OrcadLite\Capture\Library\MyLib.olb), а в графе Title Block Name – назва-
ние созданной основной надписи (в нашем случае My Title). Создав новый про-
ект, убедимся, что место основной надписи заняла созданная нами надпись, при 
этом поля с автозаполнением имеют правильные значения. 

Рис. 5.24. Часть основной надписи 

Би
бл
ио
те
ка

 БГ
УИ
Р



  70

6. ОПТИМИЗАЦИЯ РАБОТЫ ЭЛЕКТРОННЫХ СХЕМ 
 

6.1. Основные понятия 
В процессе анализа электронной схемы, созданной разработчиком, может 

оказаться, что ее функционирование не вполне отвечает требованиям техниче-
ского задания. Такое расхождение чаще всего обусловлено тем, что современ-
ные электронные схемы содержат большое число нелинейных элементов, в си-
лу чего для расчета схемы используются приближенные методы, основанные на 
различных вариантах линеаризации.  
 Для достижения требуемых технических характеристик необходимо произ-
вести коррекцию первоначальных значений параметров элементов схемы. Для 
этого существуют два пути: 

1. Многократное моделирование схемы при ручном изменении параметров 
элементов с целью определения влияния каждого из них на значения требуе-
мых выходных  характеристик с последующими подбором и фиксацией тре-
буемых значений. 

2. Автоматизированный подбор параметров с помощью программы PSpice 
Optimizer. 

Второй путь позволяет значительно сократить затраты машинного времени 
и усилия разработчика. 

Перед использованием программы PSpice Optimizer дадим определения ос-
новным понятиям: 

Оптимизация (Optimization) – процесс точной настройки работы схемы пу-
тем вариации ее параметров до достижения заданного (или наиболее близкого к 
заданному) значения глобальной целевой функции. 

PSpice Optimizer позволяет производить следующие виды оптимизации. 
Оптимизация без ограничений (Unconstrained optimization). При этом вы-

числяется экстремум одной целевой функции.  
Оптимизация при ограничениях (Constrained optimization). Вычисляется 

экстремум одной целевой функции при выполнении одного или нескольких не-
равенств. 

Минимизация по методу наименьших квадратов без ограничений (Uncon-
strained least squares). Минимизирует сумму квадратов ошибок (разниц между 
заданными и текущими значениями) для набора целевых функций. 

Минимизация по методу наименьших квадратов при ограничениях (Con-
strained least squares). Минимизирует сумму квадратов ошибок  для набора це-
левых функций при выполнении заданных неравенств. 
 Параметр (Parameter) – свойство схемы, для которого PSpice Optimizer пы-
тается определить лучшее значение в заданных пользователем пределах. В ка-
честве параметра может использоваться: 
 – номинал элемента (например емкость конденсатора); 
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 – другое свойство элемента (например положение движка потенциометра); 
 – член выражения, определяющий свойство элемента (например коэффици-
ент в записи передаточной функции). 

PSpice Optimizer может оптимизировать схему, содержащую до восьми 
варьируемых параметров. 
 Спецификация (Specification) – описание глобальной целевой функции с 
помощью локальных целевых функций и ограничений. В PSpice Optimizer су-
ществуют два типа спецификаций: 
 – внутренняя (internal specification), состоящая из целевых функций (задан-
ных своими значениями) и неравенств (заданных в виде допустимых пределов), 
которые введены в PSpice Optimizer с помощью диалоговых окон; 
 – внешняя (external specification), состоящая из результатов измерений, за-
данных в виде внешнего файла. 
 При задании спецификации необходимо указать: 
 – название (Name); 
 – значение глобальной целевой функции (Target) и ее допустимое отклоне-
ние (Range); 
 – вид анализа схемы (Analysis); 
 – название профиля моделирования либо файла-описания схемы (Simulation 
Profile or Circuit File); 
 – выражение для описания глобальной целевой функции (в графе Evaluate). 
 Спецификация также может включать: 
 – название probe-файла, содержащего описание целевых функций (Probe file 
containing Goal Functions); 
 – имя файла, содержащего результаты измерений и опорные данные (при 
использовании внешней спецификации). 
 Глобальная целевая функция (Evaluation) – функция, значение которой 
является мерой соответствия реального режима в схеме желаемому. 
 В качестве глобальной целевой функции могут выступать: 
 1. Одноточечная trace-функция программы PSpice. 
 2. Локальная целевая функция (Goal Function) программы PSpice. 
 3. Выражение программы PSpice Optimizer. 
 Trace-функция определяет требуемый выходной параметр схемы при про-
ведении одноточечного анализа (например DC sweep при фиксированном вход-
ном напряжении в 12 В).  

Примеры: V(out) для измерения выходного напряжения; I(d1) – для измере-
ния тока через диод. 
 Локальная целевая функция (Goal Function) определяет требуемый выход-
ной параметр при проведении всех остальных видов анализа, кроме одноточеч-
ного (например AC, Tran).  

Локальная целевая функция вычисляется по результатам моделирования 
схемы при фиксированных значениях параметров. Встроенные локальные це-
левые функции программы PSpice приведены в табл. 6.1. 

 

Би
бл
ио
те
ка

 БГ
УИ
Р



  72

Таблица 6.1 
Локальные целевые функции программы PSpice 

Функция Назначение Пример 
Bandwidth(выражение,  

уровень в дБ), 
 

BPBW(выражение, уровень 
в дБ) 

Ширина полосы пропускания по-
лосового фильтра, определяемая 

по заданному уровню  

Bandwidth(V(out),3) 
 

BPBW(V(out),3) 
 

CenterFreq(выражение, уро-
вень в дБ) 

Центральная частота полосы про-
пускания CenterFreq (V(5),3) 

Falltime(выражение) Длительность заднего фронта Falltime(I(R)) 

GainMargin(выр. 1, выр. 2) 

Определяет (в дБ) значение ам-
плитуды для выражения 2, при ко-

тором набег фазы выражения 1 
достигает 180О  

GainMargin(P(V(out)), 
V(out)) 

GenFall(выражение) Длительность заднего фронта оги-
бающей сигнала GenFall(V(out)) 

GenRise(выражение) Длительность переднего фронта 
огибающей сигнала GenRise(V(out)) 

HPBW(выражение, уровень 
в дБ) 

Ширина полосы пропускания 
фильтра верхних частот, опреде-

ляемая по заданному уровню 

HPBW(V(out),3) 
 

LPBW(выражение, уровень 
в дБ) 

Ширина полосы пропускания 
фильтра нижних частот  

HPBW(V(out),3) 
 

MAX(выражение) Глобальный максимум Max(I(R)) 

MAXr(выр., t1, t2) Локальный максимум выражения 
на интервале времени от t1 до t2 Maxr(V(3), 0, 2s) 

MIN(выражение) Глобальный минимум Min(I(R)) 

MINr(выр., t1, t2) Локальный минимум выражения 
на интервале времени от t1 до t2 Minr(V(3), 0, 2s) 

Overshoot(выражение)   
Определяет разницу между мак-

симальным и конечным значением 
выражения 

Overshoot(V(out))   

Peak(выражение, n) Значение выражение в n-м пике Peak(V(out), 2) 

Period(выражение) Период сигнала. Определяется от 
первого до второго импульса Period(V(out)) 

PhaseMargin(выр. 1, выр. 2) 

Определяет значение фазы выра-
жения 2, при котором амплитуда 
выражения 1 достигает значения 

ноль дБ 

PhaseMargin(V(out), 
P(V(out))) 

Pulsewidth(выражение) 

Длительность импульса   
(определяется как интервал време-

ни от середины положительного 
до середины отрицательного 

фронта) 

Pulsewidth(V(out)) 
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Окончание табл. 6.1 

Функция Назначение Пример 
Risetime(выражение) Длительность переднего фронта Risetime(V(out)) 

SWINGr(выр.,нач._x,кон_x) 
Разница между максимальным и 
минимальным значением выра-
жения в указанном интервале 

SWINGr(V(out),0,8ms) 

TPmW2(выр., период) 

Вычисляет функцию 
 (y1 – y2)*1000/(x1 – x2) 

от выражения на указанном  
периоде. 

Может использоваться для рас-
чета общей рассеиваемой мощ-
ности (в мВт) на указанном пе-

риоде, если 
выр.=интеграл(V(out)*I(out)) 

TPmW2(s(V(out)* 
I(out)), 5) 

XatNthY(выр.,зн_Y,n) 
Находит значение Х для выраже-
ния, соответствующее n-му по-
вторению заданного значения Y 

XatNthY(V(out),10,1) 

XatNthYn(выр.,зн_Y,n) 

Находит значение Х, соответст-
вующее n-му отрицательному 

фронту, для выражения пересе-
кающего заданное значение Y 

XatNthYn(V(out),10,1) 

XatNthYp(выр.,зн_Y,n) 

Находит значение Х, соответст-
вующее n-му положительному 
фронту, для выражения пересе-
кающего заданное значение Y 

XatNthYp(V(out),10,1) 

XatNthYpct(выр.,Y_в_проц.,n) 

Находит значение Х, соответст-
вующее n-му пересечению зна-

чения Y, для выражения заданно-
го в процентах от максимальной  

амплитуды 

XatNthYpct(V(out), 
50,1) 

YatX(выр., зн_X) Находит значение выражения 
при заданном значении Х YatX(V(3),20) 

YatXpct(выр.,X_в_проц.) 
Находит значение выражения 
при заданном в процентах от 

полного диапазона значений Х 
YatXpct(V(3),75) 

                                                                                                                                    
Выражение PSpice Optimizer содержит переменные, константы, функции и опе-
раторы программы PSpice Optimizer. Например, для вычисления общего сопро-
тивления двух резисторов с параметризованными значениями сопротивлений 
R1val и R2val можно использовать выражение R1val «operator» R2val, где вме-
сто «operator» необходимо использовать «+», «–», «*», « / », «**» (возведение в 
степень). Допустимо использовать также функции sin, cos, tan, atan, exp, log, 
log10. 
 Схемы, не подлежащие оптимизации: 
 1. Неработающие схемы. PSpice Optimizer не сможет «оживить» схему, со-
держащую ошибки, не позволяющие провести ее моделирование. 
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2. Схемы, содержащие элементы с несколькими состояниями (например 
триггеры), если при незначительном изменении параметра изменяется состоя-
ние схемы. 

6.2. Оптимизация схемы с помощью программы PSpice Optimizer 
 Алгоритм оптимизации схемы с помощью программы PSpice Optimizer рас-
смотрим на конкретном примере. 
 Пример: подбором номинала R5 добиться того, чтобы в схеме рис. 6.1 ток 
через нелинейный элемент (диод) составил 1мА с точностью 1 %.  

1. Промоделируем данную схему 
на постоянном токе с помощью про-
граммы Capture. Для этого соберем 
схему, проведем расчет переходного 
процесса (Time Domain), затем выве-
дем результаты расчета по постоян-
ному току, для чего из меню PSpice 
выберем пункты Bias Points → Enable, 
затем на панели инструментов на-
жмем кнопку «I». Результаты модели-
рования приведены на рис. 6.2. (На 
этом рисунке значения всех токов, 
кроме интересующего, убраны). Ви-
дим, что при данных параметрах ток 
через диод составляет 1,828 мА. 

2. Параметризируем значение со-
противления R5, для чего заменим 
значение 1К для R5 записью с именем 
параметра в фигурных скобках, на-
пример {R5val}. 

3. В программе Capture из меню 
PSpice выберем пункт Place Optimizer 
Parameters и поместим появившуюся 
рамку на удобном месте. 

4. Дважды щелкнув левой кнопкой 
мыши на  рамке, перейдем в окно вво-
да параметра, приведенное на рис. 6.3. 

Поля этого окна имеют следую-
щие назначения: 
    Name – название параметра; 

    Initial Value – значение, с которого 
начинается процесс оптимизации; 

    Current Value – текущее значение 
параметра; 

 

U=10 В 

R1 
1K 

R2 
9K 

R3 
8K 

R4 
2K 

R5 
1K VD 

Рис. 6.1. Схема примера 

Рис. 6.2. Результат расчета  
исходной схемы 

Рис. 6.3. Окно ввода параметра  
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       Tolerance – допуск на параметр. Задается для последующего выбора 
значения из стандартного ряда; 

Lower Limit – нижний допустимый предел изменения параметра; 
 Upper Limit – верхний допустимый предел изменения параметра. 
 Переключатель Simulation With позволяет проводить моделирование из 
программы Capture либо с начальным значением параметра (Initial Value), либо 
с текущим (Current Value).  

Заполним верхние поля так, как показано на рисунке, затем нажмем кнопки 
Add и ОК.  

5. Запустим программу PSpice Optimizer, выбрав в программе Capture пунк-
ты меню PSpice→Run Optimizer. В результате получим окно программы PSpice 
Optimizer, приведенное на рис. 6.4. 

 Окно состоит из трех основных 
частей: области спецификаций (Speci-
fications), области параметров (Parame-
ters), области индикатора процесса оп-
тимизации. Видим, что пока область 
спецификаций пуста.  
 6. Добавим глобальную целевую 
функцию, для чего в меню Edit данной 
программы выберем пункт Specifica-
tions. В появившемся окне нажмем 
кнопку Add, в результате чего появит-
ся окно Edit Specification, приведенное 
на рис. 6.5. Поля этого окна имеют 
следующие назначения: 

Name – название глобальной целе-
вой функции; 

Reference – источник ее описания; 
    Internal – поле Evaluate; 
    External – внешний файл; 

Target – желаемое значение гло-
бальной целевой функции; 

Range – ее допустимое отклонение; 
Constraint – наличие ограничений-

неравенств, вид которых выбирается 
из поля Type; 

Analysis – вид анализа схемы (AC, 
DC либо Tran); 

Simulation Profile or Circuit File – 
название профиля моделирования либо файла-описания схемы; 
 Probe File Containing Goal Functions – имя файла с расширением .prb, со-
держащего описание локальных целевых функций (например C:\Program 
Files\OrcadLite\PSpice\Common\pspice.prb); 

Рис. 6.5. Окно Edit Specification 

Рис. 6.4. Окно программы 
PSpice Optimizer 
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 Evaluate – описание глобальной целевой функции. 
При использовании нескольких целевых функций можно задать удельный 

вес каждой из них в графе Weigth. 
 При использовании внешнего описания целевой функции необходимо за-

полнить поля: 
 File – имя файла с данными; 
 X Column Name – заголовок столбца в файле, 
содержащего независимые (Х) значения (например 
Vbe на рис. 6.6.); 
 Y Column Name – заголовок столбца в файле, 
содержащего зависимые (Y) значения (например Ic 
на рис. 5.6.); 
 Tole6ance – допуск в процентах, задаваемый для 
последующего выбора значения параметра из стан-
дартного ряда (например 10 %). 

Заполним поля окна Edit Specifications так, как показано на рис. 6.5; закроем 
это окно, нажав ОК. После этого закроем окно Specifications с помощью кнопки 

Close. Видим, что в поле Specifications появилось окно, 
показанное на рис. 6.7. В верхней части окна находится 
переключатель, включающий/исключающий целевую 
функцию из процесса вычислений. Белое поле в сере-
дине окна содержит текущее значение функции, ниж-
нее поле – начальное значение. В правой части окна на-
ходится индикатор, показывающий соответствие значе-
ния целевой функции заданному. Если индикатор имеет 
красный цвет, то функция не достигла заданного значе-
ния, при этом по меткам в правой части шкалы можно 

видеть, больше или меньше заданного текущее значение глобальной целевой 
функции. При достижении заданного значения индикатор меняет цвет на зеле-
ный. 

7. Для того чтобы можно было запустить процесс оптимизации, необходимо 
соответствие между видом анализа, указанного в окне Edit Specification 
(см. рис. 6.5), и профилем моделирования в программе Capture. Для расчета 
схемы по постоянному току мы использовали режим Tran, поэтому необходи-
мо: 

I вариант. Снова открыть окно Edit Specification, для чего либо дважды 
щелкнуть левой кнопкой мыши на правой части окна (см. рис. 6.7), либо вы-
полнить пункты меню EditSpecifications; после чего выбрать вид анализа 
Tran. Так как Tran является многоточечным видом анализа, то в качестве гло-
бальной целевой функции в графе Evaluate  задают выражение, содержащее ло-
кальные целевые функции, например MAX(I(D1)). После выхода из окон Edit 
Specification и Specifications можно запускать процесс оптимизации. 

II вариант. Для сокращения времени моделирования задать одноточечный 

Рис. 6.6. Структура 
 файла-описания целевой 

функции 

Рис. 6.7. Окно  
глобальной целевой 

функции 
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вид анализа, для чего вернуться в программу Capture и отредактировать про-
филь моделирования, например так, как показано на рис. 6.8.  

Запустим процесс оптимизации, для 
чего в меню Tune программы PSpice Op-
timizer (см. рис. 6.4) выберем пункты Auto 
→ Start. Ход процесса отображается в ле-
вой части окна PSpice Optimizer, в кото-
рой находится индикатор, показываю-
щий, насколько далеки значения глобаль-
ных целевых функций от желаемых зна-
чений (первоначально индикатор показы-
вает 100 %). Под индикатором находятся 
поля со значениями среднеквадратиче-
ской ошибки (RMS Error), номера теку-
щей итерации, используемой для подбора 

параметров (Iteration), числа запусков процесса моделирования с помощью про-
граммы PSpice (Simulations). 

После окончания оптимизации схемы получим значение тока 1,00023 мА 
при значении сопротивления R5, равном 3,89443 К.  

8. Округлим полученное значение сопротивления до ближайшего стандарт-
ного, взятого из ряда Е12 (что соответствует указанному допуску 10 %), для че-
го выполним пункты меню EditRound Nearest. В результате получим значе-
ние R5, равное 3,9 К; при этом ток через диод будет равен 0,99937 мА. 

При наличии у разработчика достаточных оснований можно создать новое 
стандартное значение, для чего выполнить пункты меню EditRound 
Calculated. 
 9. Внесем полученное значение в схему в программе Capture, для чего вы-
полним пункты меню EditUpdate Schematic. В результате рамка Optimizer Pa-
rameter примет вид, показанный на рис. 6.9, а. 
 10. Промоделируем схему с новым значением параметра так же, как в пер-
вом пункте. Убедимся, что функционирование схемы соответствует ожидаемо-
му (рис. 6.9, б). 
 
 
 
 
 
 
 
 

 
 
 

Рис. 6.9. Результаты оптимизации схемы 

Рис. 6.8. Профиль моделирования 

а б 
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